
Contents for TreeChart Help

TreeChart is a program you can use to quickly create and print organization (or similar hierarchical) 
charts.

All box sizing and positioning is automatic - all you need to do is decide what boxes look like and what 
text to put in them.

To learn how to use Help, press F1

To see the various ways TreeChart can give you Help, see Getting Help in TreeChart.
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File menu commands

The File menu offers the following commands:

New Creates a new chart.
Open Opens an existing chart.
Close Closes an opened chart.
Save Saves an opened chart using the same file name.
Save As Saves an opened chart to a specified file name.
Print Prints the Current View of the active chart.
Print 
Preview

Displays the Current View of the active chart as it would appear when 
printed.

Print Setup Selects a printer and printer connection.
Preferences Change TreeChart program preferences.
1,2,3,4 Opens one of four most recently used files.
Exit Exits TreeChart.



Window menu commands

The Window menu offers the following commands, which enable you to arrange multiple 
views of multiple documents in the application window:

Cascade Arranges windows so that they overlap.
Tile Horizontal Arranges chart windows side by side.
Tile Vertical Arranges windows stacked vertically.
Arrange Icons Arranges icons of minimized chart windows.
Window 1, 
2, ...

Goes to specified chart window.



Help menu commands

The Help menu offers the following commands, which provide you assistance with this 
application: 

Contents Offers you an index to topics on which you can get help.
How to Use Help Provides general instructions on using help.
Search for Help 
On

Allows you to search the online help for particular 
keywords.

Register How to register the program.
About Displays the version number of this application.



New command (File menu)

Use this command to create a new chart in TreeChart. If you have specified a Template File, 
the Template File is loaded to serve as the initial settings for your new chart.

You can open an existing chart with the Open command.

Shortcuts

Toolbar:
Keys: CTRL+N



Open command (File menu)

Use this command to open an existing chart in a new window.    You can open multiple charts
at once.    Use the Window menu to switch among the multiple open charts.    See Window 1, 
2, ... command.

TreeChart displays the File Open dialog box so you can name your chart. 

You can create new charts with the New command.

You can quickly open one of the four most recently used charts with the 1,2,3,4 command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open dialog box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

There is no need to type the extension. TreeChart automatically adds an appropriate 
extension (dependent on the file format you select) to the filename you type.

List Files of Type
This controls both the file types listed in the File Name list control, and the format that 
TreeChart expects to read.

Select the type of file you want to open:

TreeChart Files (*.TCF) List: All files of type .TCF
Open: TreeChart-format file.
This is the normal format for TreeChart 
use, since it retains all chart 
information.

Template Files (*.TCT) List: All files of type .TCT
Open: TreeChart-format Template file.
TreeChart-format files to be used as 
Templates normally have the filename 
extension .TCT to indicate they serve a 
different purpose.

Text Files (*.TXT) List: All files of type .TXT
Open: Windows-format text file.
Unformatted text as saved by another 
program.

All Files (*.*) List: All files
Open: TreeChart-format file.

Drives
Select the drive in which TreeChart stores the file that you want to open. 

Directories
Select the directory in which TreeChart stores the file that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

See also Keys for working with dialog boxes.



Close command (File menu)

Use this command to close the active chart.    TreeChart suggests that you save changes to 
your chart before you close it.    If you close a chart without saving, you lose all changes 
made since the last time you saved it.    Before closing an untitled chart, TreeChart displays 
the Save As dialog box and suggests that you name and save the chart.

Shortcuts
Keys: CTRL+F4

You can also close a chart window by double-clicking the chart's Control menu button, as 
shown below:



Save command (File menu)

Use this command to save the active chart to its current name and directory.    When you 
save a chart for the first time, TreeChart displays the Save As dialog box so you can name 
your chart.    If you want to change the name and directory of an existing chart before you 
save it, choose the Save As command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As command (File menu)

Use this command to save and name the active chart.    TreeChart displays the Save As 
dialog box so you can name your chart.    

To save a chart with its existing name and directory, use the Save command.



File Save As dialog box

The following options allow you to specify the name and location of the file you're about to 
save:
File Name

Type a new filename to save a chart with a different name.    A filename can contain up to
eight characters and an extension of up to three characters.

There is no need to type the extension. TreeChart automatically adds an appropriate 
extension (dependent on the file format you select) to the filename you type.

Save File as Type
Select the file format you wish to save the chart in:

TreeChart File (.TCF) A TreeChart-format file.
Use this format to retain all chart 
information. This is the normal format 
for TreeChart use.

Template File (*.TCT) A TreeChart-format Template file.
TreeChart-format files to be used as 
Templates normally have the filename 
extension .TCT to indicate they serve a 
different purpose.

Text & Commas (.TXT) A Windows-format data file.
Suitable for use with a word processor or
spreadsheet. Contains only Box text; no 
Layout or hierarchy information.

Text & Tabs (.TXT) A Windows-format data file.
Suitable for use with a word processor or
spreadsheet. Contains only Box text; no 
Layout or hierarchy information.

Outline Text (.TXT) A Windows-format data file.
Similar to Text & Tabs, but containing 
Text Field names & Box hierarchy 
information, plus the name of a Layout 
(but not its settings).

Windows Metafile 
(.WMF)

A picture of the Current View of the 
chart, similar to as it would be printed.

Drives
Select the drive in which you want to store the chart.

Directories
Select the directory in which you want to store the chart.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

See also Keys for working with dialog boxes.





1, 2, 3, 4 command (File menu)

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
charts you closed.    Choose the number that corresponds with the chart you want to open.



Exit command (File menu)

Use this command to end your TreeChart session.    You can also use the Close command on 
the application Control menu.    TreeChart prompts you to save charts with unsaved changes.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4



Toolbar command (View menu)

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in TreeChart, such as File Open.    A check mark appears next to 
the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.

Shortcuts
Keys: SHIFT+F2



Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many commands used in TreeChart,

To hide or display the Toolbar, choose Toolbar from the View menu, or press SHIFT+F2.

In addition to the command buttons listed below, the toolbar also enables the zoom factor of
the current chart window to be altered, by means of a drop-down list.

See also Keys to access Toolbar buttons.

Click To

Open a new chart.

Open an existing chart.    TreeChart displays the Open dialog box, in which you can 
locate and open the desired file.

Save the active chart or template with its current name.    If you have not named the 
chart, TreeChart displays the Save As dialog box.

Cut selected boxes from the chart and stores them on the clipboard.

Copy selected boxes to the clipboard.

Paste Below (insert) the contents of the clipboard below the Current Box.

Select all boxes.

Select Sub-Tree - Select the Current Box    and all boxes below it.

Select Level - Select all boxes at the level of the Current Box.

Select Subordinates - Select all boxes immediately below the Current Box.

Mark Boxes as exceptions to the rules.

Define Layouts - Create, rename, edit, change use of a Layout.

View All boxes, by removing Focus and expanding all collapsed boxes.



Focus on the Current Box and all boxes below it; hide boxes on other branches.

Collapse selected boxes, hiding all boxes below them.

Expand selected boxes, revealing all boxes below them.

Expand all collapsed boxes.

Print the Current View of the active chart.

Preview printing.

Enter context-sensitive Help mode.



Status Bar command (View menu)

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.

Shortcuts
Keys: CTRL+F2



Status Bar

The status bar is displayed at the bottom of the TreeChart window.    To display or hide the 
status bar, use the Status Bar command in the View menu, or press CTRL+F2.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
Toolbar buttons as you depress them, before releasing them.    If after viewing the 
description of the Toolbar button command you wish not to execute the command, then 
release the mouse button while the pointer is off the Toolbar button.

The left area of the status bar also advises when some longer duration actions are in 
progress, such as opening or saving files.

The right areas of the status bar indicates chart and keyboard status:

Indicator Description
Total Levels The number of levels in the active chart.
Current Level The level of the Current Box in the active chart.
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.
Total boxes The number of boxes in the active chart.
Hidden boxes The number of boxes in the active chart hidden using outlining. If this 

indicator is not blank, the Current View is not the whole chart.
Some of the Status Bar fields reflect the conditions in the active chart. If you switch to a 
different
chart, the information is updated to reflect the conditions in the activated chart.



Tile Horizontal (Window menu)

Moves and resizes all open chart windows, then arranges them side-by-side so they are all 
visible and none of them overlap.



Cascade command (Window menu)

Moves and resizes all open chart windows, then arranges them in an overlapped fashion.



Tile Vertical command (Window menu)

Moves and resizes all open chart windows, then arranges them stacked vertically so they are
all visible and none of them overlap.



Arrange Icons command (Window menu)

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open chart window at the bottom of the main window, then some or 
all of the icons may not be visible because they will be underneath this chart window.



1, 2, ... command (Window menu)

TreeChart displays a list of currently open chart windows at the bottom of the Window menu. 
A check mark appears in front of the chart name of the active window.    Choose a chart from
this list to make its window active.    



Contents command (Help menu)

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using TreeChart and various types of reference 
information.    

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.

Shortcuts
Keys: CTRL+F1



Using Help command (Help menu)

Use this command for instructions about using Help.



Search For Help command (Help menu)

Use this command to search TreeChart's online Help for particular keywords.

The Search dialog box is displayed:

1 Type a keyword, or select one from the list of recognised 
keywords.

2 Choose Show Topics (or double-click on the keyword list) 
to show a list of topics with the selected keyword.

3 Select a topic from the list and choose Go To (or double-
click the topic list) to go to the selected Help topic.

Once you open Help, you can click the Search button whenever you want to search the 
online Help by keyword.

See also Keys for working with dialog boxes
.



About command (Help menu)

Use this command to display the copyright notice and version number of your copy of 
TreeChart.



Help Mode command 

Use the Help mode command to obtain help on some portion of TreeChart.

When you choose the Toolbar's Help Mode button, the cursor will change to .    Then click
somewhere in the TreeChart window, such as another Toolbar button or a menu item.    The 
Help topic will be shown for the item you clicked.

Pressing ESC while the Help Mode cursor is displayed returns you to normal working without 
getting Help.

Shortcut
Keys: SHIFT+F1



Title Bar

The title bar is located along the top of a window.    It contains the names of the application 
and the active chart.

To enlarge a window to full size, double-click on the title bar.

To move the window, drag the title bar.    Note: You can also move dialog boxes by dragging 
their title bars.

A title bar may contain the following elements:
Application Control-menu button
Chart Control-menu button
Maximize button
Minimize button
Name of the application
Name of the active chart
Restore button



Scroll bars

Displayed at the right and bottom edges of the chart window.    The scroll boxes inside the 
scroll bars indicate your vertical and horizontal location in the chart.    You can use the mouse
to scroll to other parts of the chart.

See also Keys for scrolling a chart window.



Size command (System menu)

Use this command to display a four-headed arrow so you can size the active window with the
arrow keys.

After the pointer changes to the four-headed arrow:
1. Press one of the DIRECTION keys (left, right, up, or down arrow key) to move the pointer 

to the border you want to move.    
2. Press a DIRECTION key to move the border.
3. Press ENTER when the window is the size you want.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the size bars at the corners or edges of the window.



Move command (Control menu)

Use this command to display a four-headed arrow so you can move the active window or 
dialog box with the arrow keys.

Note:    This command is unavailable if you maximize the window.

Shortcut
Mouse: Drag the title bar.



Minimize command (application Control menu)

Use this command to reduce the TreeChart window to an icon.

Shortcut

Mouse: Click the minimize icon  on the title bar.



Maximize command (System menu)

Use this command to enlarge the active window to fill the available space.

Shortcut

Mouse: Click the maximize icon  on the title bar; or double-click the title bar.



Next Window command (chart Control menu)

Use this command to switch to the next open chart window.    TreeChart determines which 
window is next according to the order in which you opened the windows.

Shortcut
Keys: CTRL+F6



Previous Window command (chart Control menu)

Use this command to switch to the previous open chart window.    TreeChart determines 
which window is previous according to the order in which you opened the windows.

Shortcut
Keys: SHIFT+CTRL+F6



Close command (Control menus)

Use this command to close the active window or dialog box.

Double-clicking a Control-menu box is the same as choosing the Close command.

Shortcuts
Keys: CTRL+F4 closes a chart window

ALT+F4 closes the TreeChart window or a dialog box



Restore command (Control menu)

Use this command to return the active window to its size and position before you chose the 
Maximize or Minimize command.



Switch to command (application Control menu)

Use this command to display a list of all open applications.    Use this "Task List" to switch to 
or close an application on the list.

Shortcut
Keys: CTRL+ESC

Dialog Box Options
When you choose the Switch To command, you will be presented with a dialog box with the 
following options:
Task List

Select the application you want to switch to or close.
Switch To

Makes the selected application active.
End Task

Closes the selected application.
Cancel

Closes the Task List box.
Cascade

Arranges open applications so they overlap and you can see each title bar.    This option 
does not affect applications reduced to icons.

Tile
Arranges open applications into windows that do not overlap.    This option does not 
affect applications reduced to icons.

Arrange Icons
Arranges the icons of all minimized applications across the bottom of the screen.

See also Keys for working with dialog boxes



Choose Font dialog box

The following options allow you to specify a font and its style:
Font

Select from the list of available fonts. TreeChart lists only those fonts that are available 
on the current printer and for screen use.

Style
Select the font style. Options listed depend on the selected Font, but normally include 
options such as Regular, Bold and Italic.

Size
Select the point size you require.

Strikeout
Select this checkbox to enable text strikeout.

Underline
Select this checkbox to enable text underlining.

Color
Select a color for the text.

See also Keys for working with dialog boxes



Choose Color dialog box:

Box Fill Color
Box Border Color
Box Shadow Color
Connections Line Color
Background Color
Border Color
Border Shadow Color

This dialog allows you to choose a color. It is initially presented as a simple color-picker, 
offering up to 48 preset colors chips and 16 custom colors chips. You can expand the dialog 
to define a color different to the displayed preset and custom colors, or to change the 
custom colors.

The actual number of preset colors displayed is determined by the display driver. For 
example, a VGA driver displays 48 colors, and a monochrome display driver displays only 16.

TreeChart allows you to store 16 custom colors with each chart. These all default to white 
unless you define different colors in a Template File.

If the color you are changing matches one of the preset or custom colors, that color chip will 
be selected initially.

See also Keys for working with dialog boxes

To select an existing color:

Click on the color chip, then click on OK.

To modify a custom color:

Click on the custom color chip, then choose the Define Custom Colors button. The dialog is 
expanded to enable you to define a new color. Change the color (see below), then choose 
the Add to Custom Colors button to update the custom color chip.

To define a custom color:

Click on Define Custom Colors. The dialog is expanded to enable you to define a new color.

Specify red, green, and blue (RGB) values by using the Red, Green, and Blue edit controls.

or

Specify hue, saturation, and luminosity (HSL) values by using the Hue, Sat, and Lum edit 
controls.

or

Click on the color spectrum control (at the upper-right of the dialog box) to select hue and 
saturation values; click on the luminosity control (the rectangle to the right of the spectrum 
control). This method is only available if you have a mouse.

Whichever technique you use...



The Color|Solid control displays the dithered and solid colors that correspond to your 
selection. (A dithered color is a color created by combining one or more pure or solid colors.)
Note that most Windows devices are unable to use dithered colors to draw lines. Generally 
speaking, therefore, color use is:

Box Fill Color Dithered
Box Border Color Solid
Box Shadow Color Dithered
Connections Line Color Solid
Background Color Dithered
Border Color Solid
Border Shadow Color Dithered

Selecting OK after defining a color causes that color to be used; selecting Cancel leaves your
chart unchanged (though the custom colors may have been changed). If you wish to add the
newly-defined color to your table of custom colors, you must choose the Add to Custom 
Colors button before selecting OK or Cancel.

Color Models Used by the Choose Color Dialog Box

The Color dialog box uses two models for specifying colors: the RGB model and the HSL 
model. Colors you define are presented in both models, but you'll probably find things 
simpler if you define your colors using the model you feel most comfortable with.

RGB Color Model

The RGB (red, green, blue) model is used to designate colors for displays and other devices 
that emit light. Valid red, green, and blue values are in the range 0 through 255, with 0 
indicating the minimum intensity and 255 indicating the maximum intensity. (With display 
devices, the color black results when the red, green, and blue values are set to 0--that is, 
with display technology, black is the absence of all colors.) 

Following are eight example colors and their associated RGB values: 

Color RGB values

Red 255, 0, 0 
Green 0, 255, 0 
Blue 0, 0, 255 
Cyan 0, 255, 255 
Magenta 255, 0, 255 
Yellow 255, 255, 0 
White 255, 255, 255 
Black 0, 0, 0 

HSL Color Model

The Color dialog box provides controls for specifying HSL (hue, saturation, luminosity) 
values.

To the right of the dialog is a luminosity control. The square color spectrum has saturation on
the vertical axis, and hue on the horizontal axis.

Note that after selecting a white (or near-white) color chip, for instance an unused Custom 



Color, the initial luminosity will be maximum, which would cause the color to be white 
whatever the hue and saturation settings. If you find that changing hue or saturation has no 
effect on the Color|Solid control, you need to adjust the luminosity first.

The saturation and luminosity values are forced to be in the range 0 through 240 and the 
hue value is forced to be in the range 0 through 239.



Next Pane

<< Write application-specific help here. >>



Prev Pane

<< Write application-specific help here. >>



Working in a Chart Window

In a word processor, a document window allows you to manipulate text. In a drawing 
program, a document window allows you to manipulate picture elements (which might 
include lines, rectangles and text).

In a TreeChart chart window, you are manipulating boxes, not lines, rectangles or text. You 
can insert, delete and re-arrange boxes directly, but you can not directly select or change 
the text within boxes, the style of text or boxes, or how connecting lines are routed.

These attributes of boxes are changed by means of dialog boxes, each shown as a result of 
choosing a menu command or pressing a shortcut key. Whenever you change something, 
TreeChart automatically:

- Re-calculates how large boxes need to be to contain the text

- Re-positions boxes

- Re-routes connecting lines

Although re-calculating the chart is automatic, you have a considerable degree of control 
over how the re-calculation is done.

The chart background color is used as the background color of the chart window.

See also:

Boxes and Layouts
Inserting Boxes
Keyboard Shortcuts
Moving around a chart
Outlining
Selecting Boxes
Using a mouse in a Chart Window
Zooming the Chart Display



No Help Available

No help is available for this area of the window.



No Help Available

No help is available for this message box.



Preferences command (File menu)

A number of options determining the operation of TreeChart can be specified by the user. All 
options can be saved in an initialisation file, and restored the next time the program is 
started. Most options can be set by means of the Preferences dialog box.



Preferences dialog box

A number of options determining the operation of TreeChart can be specified by the user. All 
options can be saved in an initialisation file, and restored the next time the program is 
started. Most options can be set by means of this dialog.

Choosing the OK button completes the dialog, and any changes to the preferences will take 
effect from then on. Choosing the Cancel button completes the dialog with preferences left 
unchanged.

See also Keys for working with dialog boxes

Clipboard

The checkboxes in the Clipboard group determine the optional formats the program uses 
when copying or cutting information to the Clipboard. The program always copies 
information in an internal format for its own use. Other formats are for transferring 
information to other programs.

There are two formats in which we can usefully copy information: as text or as a picture. 
TreeChart will happily copy both, but this can lead to difficulties in pasting information into 
other programs.

Choosing Paste in another program requires that program to choose one of the available 
Clipboard formats. All programs tend to choose one format in preference to another. Word 
processors, for example, have a tendency to paste the text copy, rather than the picture 
copy.

Many more recent Windows programs offer the Paste Special command, usually on an Edit 
menu. Using this you can select the format to be pasted into the document.

By setting these options, you can determine in what format the information is presented to 
other
programs, and either avoid the need for Paste Special (where available), or ensure they 
make the right choice.

Dialog Positions

The checkbox Center Dialogs determines where dialog boxes are displayed. If checked, 
dialog boxes are centered in the screen.

Action after Inserting a Box

The checkbox Edit After Insert determines what happens when a new Box is inserted.

If this option is selected the Edit Text Fields dialog box. is displayed automatically, to allow 
you to enter the text fields associated with the newly-inserted box. Disabling this option 
allows the structure of the chart to be entered without dealing with the actual text within 
boxes until later.

Template File

A Template file can form the basis of a newly created chart, or a chart created by opening a 
text format file. This dialog enables a file to be selected for use as the Template. This can 



either be a full pathname (IE including drive & directories) or a relative pathname. If the 
latter, the program will look in the default working directory for the file. The default working 
directory can be specified as you start the program.

To use TreeChart's built-in default settings rather than a Template File, simply clear the 
Template File edit control.

The selected Template will continue to be used until you select a different Template File. The 
Template File name is stored in TreeChart's initialisation file, and if you choose to save your 
program preferences, the selected Template will also be used the next time you start 
TreeChart. If you don't save your program preferences, the Template File will be reset the 
next time you start TreeChart.

Choose the Browse button to show the Select Template dialog box, from which you can 
select the file you want to use as a Template.

See also Speeding up your work with Template Files.

Saving Preferences

Choosing the Save button causes the preferences as they appear on the dialog at that 
moment to be stored in the program's initialisation file immediately.

Selecting the Save Preferences on Exit checkbox causes the program to store the 
preferences in the initialisation file when you close the program.



Getting Help in TreeChart

Extensive online Help is always available to you when you are working with TreeChart. Help 
is
offered on a context-sensitive basis. This means that the help offered normally depends on 
what you were doing when you requested help.

Command Prompts

The first level of help offered is command prompts. Whenever you highlight a menu item or 
press (but don't release) a Toolbar button, a description of the command is displayed in the 
Status bar prompt field (if the Status bar is shown).

Online Help

TreeChart uses the standard Windows Help facility. Once the Help facility has been started, 
you are free to browse amongst topics, search for key words or phrases, add your own 
annotations to topics, or print topics. If you are unsure how to use Help, choose How to Use 
Help from the Help menu in either TreeChart or Help itself, or press F1 when you are in Help.

Help menu

The TreeChart Help menu enables you to start the Help facility with an overall contents 
presented. This can be useful if you are unsure what you need help on.

The Help menu also enables you to search the online Help for particular keywords.

Context-sensitive Help

Pressing F1 requests context-sensitive Help. The topic initially shown depends on what you 
were doing when your pressed F1; if you press F1 while a menu command is highlighted, 
rather than perform the command, help on the command is presented. If you press F1 while 
a dialog or message box is shown, help on that dialog or message box is presented.

Once you have started the Help facility, you are free to browse among topics as normal. 

Help mode

Pressing SHIFT+F1 (or selecting the Help Mode button in the toolbar) stops normal TreeChart
operation, and allows you to select something you'd like help on.

In this mode the cursor changes to ; just select a menu command or click the left mouse
button over a part of the TreeChart window to select the help topic. If you select a command,
rather than performing the command, help on the command is presented.

Pressing ESC leaves this mode without presenting help.

If you don't have a mouse, you are limited to selecting menu commands.



Select Template dialog box

The following options allow you to specify which Template File to use when you create a new 
chart or open a text-format file:

File Name
Type or select the filename you want to use as the Template.    This box lists files with the
extension you select in the List Files of Type box. 

There is no need to type the extension. TreeChart automatically adds an appropriate 
extension (dependent on the file format you select) to the filename you type.

List Files of Type
This controls the file types listed in the File Name list control. You can only specify a 
TreeChart-format file as the Template.

Select the type of file you want to list:

Template Files (*.TCT) List: All files of type .TCT

TreeChart Files (*.TCF) List: All files of type .TCF

All Files (*.*) List: All files

Drives
Select the drive in which TreeChart stores the file that you want to use as the Template.

Directories
Select the directory in which TreeChart stores the file that you want to use as the 
Template.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

See also Keys for working with dialog boxes.





Print command (File menu)

Use this command to print a chart.      This command presents a Print dialog box, where you 
may specify the range of pages to be printed, the number of copies, the destination printer, 
and other printer setup options.

Note that the Current View (as defined by outlining selections) is always printed, rather than 
the whole chart.

Shortcuts

Toolbar:
Keys: CTRL+P



Print dialog box

The following options allow you to specify how the chart should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change the
printer and printer connection.

Setup
Displays a Print Setup dialog box, so    you can select a printer and printer connection.

Print Range
Specify the pages you want to print:
All Prints the Current View of the active chart.
Pages Prints the range of pages you specify in the From and To boxes.

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.

See also Keys for working with dialog boxes



Print Progress Dialog

The Printing dialog box is shown during the time that TreeChart is sending output to the 
printer.    The page number indicates the progress of the printing.

To abort printing, choose Cancel.



Print Preview command (File menu)

Use this command to display the Current View of the active chart as it would appear when 
printed.

When you choose this command, the main window will be replaced with a print preview 
window in which one or two pages will be displayed in their printed format.    The print 
preview toolbar offers you options to view either one or two pages at a time; move back and
forth through the chart; zoom in and out of pages; and initiate a print job.

Shortcuts

Toolbar:



Print Preview toolbar

The print preview toolbar offers you the following options:
Print

Bring up the print dialog box, to start a print job.
Next Page

Preview the next printed page.
Prev Page

Preview the previous printed page.
One Page / Two Page

Preview one or two printed pages at a time.
Zoom In

Take a closer look at the printed page.
Zoom Out

Take a larger look at the printed page.
Close

Return from print preview to the main TreeChart window.



Print Setup command (File menu)

Use this command to select a printer and a printer connection.    This command presents a 
Print Setup dialog box, where you specify the printer and its connection.



Print Setup dialog box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the chart is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.

See also Keys for working with dialog boxes



Layout menu commands

The Layout menu offers the following commands:

Define 
Layouts

Define Layouts.

Edit Edit the Layout used by the Current Box.
Size Modify the box size rules of the Layout used by the Current Box.
Spacing Modify the spacing rules of the Layout used by the Current Box.
Use Default Selected boxes use their Default Layouts.
Defaults Define a default Layout for each level in the chart.
Delete 
Unused

Delete unused Layouts.

Define Layouts command (Layout menu)

Use this command to create a new Layout, rename a Layout or change which Layout is used 
by the selected boxes.

TreeChart displays the Define Layouts dialog box..    

Shortcuts

Toolbar:
Keys: CTRL+D



Edit Layout command (Layout menu)

Use this command to edit the Layout used by the Current Box. TreeChart displays the Edit 
Layout dialog box.

To edit other Layouts, use the Define Layouts dialog box    , which TreeChart displays if you 
select the Define Layouts command.    

Shortcuts
Mouse: SHIFT+double click on box
Keys: SHIFT+ENTER



Box Size command (Layout menu)

Use this command to change the box size settings of the Layout used by the Current Box.    
TreeChart displays the Box Size dialog box..    

To change the box size settings of other Layouts, use the Define Layouts dialog box..    , 
which TreeChart displays if you select the Define Layouts command..    

Shortcuts
Keys: F8



Box Spacing command (Layout menu)

Use this command to change the box spacing settings of the Layout used by the Current 
Box.    TreeChart displays the Box Spacing dialog box..    

To change the box spacing settings of other Layouts, use the Define Layouts dialog box..    , 
which TreeChart displays if you select the Define Layouts command..    

Shortcuts
Keys: SHIFT+F8



Use Default Layouts command (Layout menu)

Use this command to instruct TreeChart to set all selected boxes to use the Default Layout 
defined for their level in the chart. If no boxes are selected, the command changes the 
Layout used by the Current Box.

See Selecting Boxes for a summary of the commands to select boxes.

Default Layouts are defined using the Default Layouts dialog box

Shortcuts
Keys: CTRL+U



Default Layouts command (Layout menu)

Use this command to change the Default Layouts.    TreeChart displays the Default Layouts 
dialog box..    



Delete Unused Layouts command (Layout menu)

Use this command to delete any Layouts you no longer need.    TreeChart displays the Delete
Layouts dialog box..    

You cannot delete a Layout if it is used by any box or one of the Default Layouts.



Define Layouts dialog box

This dialog allows:

new Layouts to be created,
existing Layouts to be renamed or edited,
different Layouts to be used for selected boxes,
Default Layouts to be changed and
Unused Layouts to be deleted.

The dialog lists all existing Layouts, with the Layout used by the Current Box selected 
automatically.

Choose the Close button to complete the dialog and return to your chart window.

The dialog has a Close button rather than OK and Cancel since all of the operations available
from this dialog are performed immediately, and cannot be undone. Most of these 
operations, however, are actually performed via secondary dialogs, and in these secondary 
dialogs you have the choice whether to proceed with or cancel changes you have made.

See also Keys for working with dialog boxes.

To create a new Layout

Newly created Layouts are always a copy of an existing Layout. When selecting an existing 
Layout, choose one that most closely matches how you'd like the new Layout to look. This 
will minimise the number of changes you need to make when you edit the new Layout.

1 Select an existing Layout
2 Enter the name of the new Layout in the New Name edit control.
3 Choose the New button

Layout names must be unique. If you try to create a new Layout with the same name as an 
existing Layout, TreeChart will refuse to accept the name.

The newly-created Layout will be added to the Layout list, and automatically selected, since 
you are almost certain to want to edit it.

Creating a new Layout takes immediate effect, and cannot be undone. If you make a 
mistake, you should either Rename or Delete the new Layout.

To edit a Layout

1 Select the Layout you wish to edit.
2 Choose the Edit button.

As an alternative, you can double-click on the Layout name.

The Edit Layout dialog appears.

To rename a Layout

1 Select the Layout you wish to rename
2 Enter the new name in the edit control.



3 Choose the Rename button

Layout names must be unique. If you try to rename a Layout with the same name as an 
existing Layout, TreeChart will refuse to accept the name.

Renaming a Layout takes immediate effect, and cannot be undone. If you make a mistake, 
you should repeat the Rename operation.

To use a Layout for selected boxes

1 Select the boxes before you enter the Define Layouts dialog.
2 Select the Layout the selected boxes should use.
3 Choose the Use button

See Selecting Boxes for a summary of the commands to select boxes.

Using a different Layout takes immediate effect, and cannot be undone. If you make a 
mistake, you should repeat the Use operation.

To change the Default Layouts

1 Choose the Defaults button.

The Default Layouts dialog appears.

This command is also available on the Layout menu.

To delete unused Layouts

1 Choose the Delete button.

The Delete Unused Layouts dialog appears.

This command is also available from the Layout menu.



Edit Layout dialog box

This dialog allows you to change every aspect of a box's appearance, and provides 
immediate feedback on the effects of any changes you make. Feel free to try various 
combinations of options; you can always cancel the changes if you want.

Note that the title bar of the Edit Layout dialog always contains the name of the Layout 
being edited.

The sample providing feedback uses the Text Field Names to indicate Field position & 
appearance. When the Layout is subsequently used as we draw the chart, the size of the box
is determined by further factors, such as the length of the text and the chart-wide Size 
Matching rules. Boxes will always be made big enough to contain the text you have entered.

The chart background color is used as the background color of the sample.

Completing the dialog causes all changes to be reflected in all boxes currently using this 
Layout.

Cancelling the dialog leaves your chart unchanged.

See also Keys for working with dialog boxes.

Text Controls

This group of controls allows you to change all options affecting how text appears:

- Which Text Fields are visible
- Vertical placement
- Horizontal alignment
- Font, size & color

All the text controls affect only the Text Field selected in the drop-down list of Field Names. 
You
must first select the Field you wish to change. The first defined Field is always selected
automatically when you commence this dialog.

The Hide checkbox determines whether the selected Field is visible or hidden. If the Field is 
hidden, all other text controls are disabled, since it seems unwise to change options you 
can't see the effect of, and will have no effect if modified.

The Font button causes a font selection dialog to appear. This allows not only the facename 
and size to be selected, but also the color and a number of effects (like underline).

The Horizontal Alignment list allows the selected Field to be positioned horizontally within 
the box: Left-aligned, Centered or Right-aligned.

The Vertical Alignment list allows the selected Field to be positioned vertically with respect
to the box: Above the box, Top-aligned, Centered, Bottom-aligned or Below the box. Text 
above or below the box will obscure any connecting lines that interfere with it.

Note that the various margins affecting the Horizontal & Vertical position are defined by the 
Size
button in the group of controls affecting the box itself.



The Up & Down buttons move the selected Field up & down. When a Field swaps order with 
a Field with a different Vertical alignment, the Vertical Alignment of this Field is automatically
updated to reflect this. These buttons are disabled when the selected Field can't go any 
further up (or down).

Box Controls

This group of controls allows you to change all options affecting how the box itself appears:

- The box shape
- Drop-shadow direction, depth & color
- Border width & color
- Internal color
- Box Size control

The Box Shape list allows you to choose the basic shape of the box. This can be augmented 
by
selecting aspect ratio options when specifying the box size.

The Size button presents the Box Size dialog, which allows minimum box size, Box aspect 
ratio and text margins to be defined.

The Shadow list allows you to choose a drop-shadow style (including no shadow). You can 
choose from three shadow depths in each of four directions.

The Border Width list offers a number of preset line widths (including no Border).

The Colors group of buttons all present an identical color selection dialog. to allow you to 
select the Border, Fill and Shadow colors.

If you select the Transparent checkbox, the Box Fill Color is ignored, and the color is 
automatically the same as whatever is underneath the box.

Connections Controls

This group of controls allows you to change all options affecting how this box is connected to
its
subordinates:

- Relative position, alignment & spacing of this box & subordinates
(the routing of connecting lines is implied by this)

- The width & color of the connecting lines

The Style list offers a number of preset styles. These can then be modified by choosing an 
alignment for subordinates. See below for more details.

The Line Width list offers a number of preset line widths (including no lines).

The Line Color button presents a color selection dialog.

The Spacing button presents the Box Spacing dialog, which allows various distances 
between this box and its subordinates to be defined.

Connections Style and Alignment



As mentioned above, the most important controls of the Connections section of the Edit 
Layout dialog select the relative position, alignment and spacing of a box using this Layout 
and its subordinates.

The arrangement of boxes is determined by the selections in two Connections list controls:

Style
Child Align

We suggest that the easiest way to understand the effect of these controls is to try various 
combinations of selections and watch the effect on the sample in the dialog.

Connections Style

This pictorial list indicates box arrangement and the routing of connecting lines. The way 
that subordinate boxes are positioned and the way connecting lines are routed should 
generally be obvious, but a few aspects of the Style need a bit of further explanation.

Stretching the Parent box

Some styles have a parent box drawn wider than normal. This means that when re-
calculating the chart, TreeChart will automatically stretch the parent box to make it 'cover' 
the subordinate boxes, as illustrated here:

Stretching boxes is done after calculating their minimum size and size matching; if the 
parent is already bigger than its 'stretched' width, it will not be made smaller.

Parent Alignment

After positioning subordinates (across or down), the parent box is positioned.

The basic options can be summarised as follows:

The parent connection point is the left edge of the left-most subordinate - Offset margin
The parent center is the mid-point between the left-most and right-most subordinate edges
The parent connection point is the right edge of the right-most subordinate + Offset margin

For example:

The following options are only available where subordinates are placed across:

The parent center matches the center of left-most subordinate



The parent center matches the center of subordinate nearest the mid-point
The parent center matches the center of right-most subordinate

For example:

If Above Center alignment is selected and there are only two subordinates, the alignment is 
interpreted as Center (it looks strange otherwise).

Options that make use of the Offset Distance margin are indicated with a filled box. Options 
that ignore the Offset Distance margin are indicated with a hollow box. The Offset Distance 
margin can be set using the Box Spacing dialog.

Not all styles offer all alignment options.

Boxes that surround (or frame) subordinate sub-trees

Two styles cause the parent to surround (or frame) its subordinate sub-trees, after 
positioning the subordinate sub-trees across or down:

The size of the parent box is automatically calculated; the subordinate sub-trees effectively 
replace any vertically-centered text. Any vertically centered text is normally hidden, but will 
be shown if the box has no subordinates, or if its subordinates have been hidden by using 
outlining techniques.

The distinction between Box Size and Spacing is less obvious with these styles: the distances
between subordinates are specified in the Box Spacing dialog, while the distances between 
the subordinates and the frame (& its text) are specified in the Box Size dialog.

You can specify a specific aspect ratio for a surrounding box, but not a minimum size. 
Surrounding boxes are also ignored when matching box sizes.

If you select a box which frames other boxes, it is highlighted slightly differently: instead of 
inverting the whole box, only the area outside the surrounded sub-trees is inverted.

If you use outlining to Focus on a framed sub-tree, you can choose whether TreeChart 
regards the frame color as the chart background color, or whether the Border background 
color is retained. See adding titles and a border for details.

Positioning some boxes across, and some boxes down



Two styles position some subordinates down the page as a list, then position this list and 
remaining subordinates across the page:

The two styles offer Center or Center-Above parent alignment.

TreeChart automatically determines which subordinates to group into a list: it lists those 
subordinates that don't themselves have subordinates.

In an Organization Chart, managers would be positioned across, while non-managers would 
be listed. In a parts list, sub-assemblies would be positioned across, while individual 
components would be listed.

In general terms, children that are parents in their own right are positioned across, children 
who are not also parents are listed. Using outlining facilities has no effect on this: a 
collapsed box is still a parent, even though its children are hidden.

The order of subordinates is significant for these styles, since only adjacent non-parents are 
formed into a list. To form all non-parents into a single list, they must be adjacent. Note that 
boxes marked as Assistants are not regarded as non-parents. If you find that non-parents 
have unexpectedly been grouped into two lists, its probably because you've marked one of 
the subordinates as an Assistant. To group the parents into a single list, swap the position of 
the Assistant with another box.

Since these styles are hybrids of the basic across or down styles, they use both sets of 
distances to specify the spacing between boxes.

Child Alignment

The Child Align list specifies how subordinates are to be aligned as they are positioned, as 
specified by the Style. The options offered depend on whether the subordinates are 
positioned across or down.

If subordinates are positioned across, either the Top, the Bottom or the Center of the 
subordinate
boxes will be in a straight (horizontal) line. If the subordinate boxes all happen to have the 
same
height, the Child Align setting is irrelevant. As an illustration, the first three styles (above) 
used Top-align for subordinates, while the Straight Down style used Center-align for 
subordinates.

If subordinates are positioned down, either the Left, the Right or the Center of the 
subordinate boxes will be in a straight (vertical) line. If the subordinate boxes all happen to 
have the same width, the Child Align setting is again irrelevant.

As mentioned above, two Connections Styles list some subordinates, then position these 
lists and remaining subordinates across. Child alignment control for these styles is basically 
as if all subordinates were placed across: listed subordinates are always Left-aligned, then 
treated as a single large box. For example, selecting Bottom for Child Alignment results in 



the bottom of each subordinate placed across being in a straight (horizontal) line with the 
bottom of the lowest listed box.



Box Size dialog box

This dialog allows you to specify the various Layout factors affecting the size of boxes.

Note that the title bar of the Box Size dialog always contains the name of the Layout being 
edited.

There are two aspects to specifying the size of boxes using this Layout:

- Text Margins
- Size Control

See Entering Measurements for details of entering measurements.

See also Keys for working with dialog boxes.

Text Margins

Boxes are always big enough to contain their associated text, then various margins are 
added before determining the actual box size. The meaning of the eight margins is 
illustrated by the following diagram:

Text fields having the same vertical alignment always have single line spacing.

The Above, Below, TopMiddle and BottomMiddle margins are only used if there are text fields
above, below, top or bottom vertically aligned respectively. If this is not the case, these 
margins are totally ignored and have no effect on box size or spacing.

The Top, Bottom, Left and Right margins have, in a sense, two meanings:

In determining the initial box size, TreeChart calculates how much space is needed for the 
text, then adds these margins to determine an initial box size. If Box Size rules specify a 
minimum, or Size Matching rules require equal sized boxes, the box may then be made 
bigger.

When drawing a box, these margins are subtracted from the box size to determine where 
to place text. The overall effect, therefore, is that right-aligned text field (for example) will 
always be a fixed distance from the right edge of the box, irrespective of how wide the box is
made to satisfy Size Matching rules.



Note that centered text (both vertically and horizontally) is centered within the region 
defined by the final box size minus the Top, Bottom, Left and Right margins. If your Top and 
Bottom margins aren't equal, or if your Left and Right margins aren't equal, the text will not 
be centered with respect to the box.

The checkboxes Push Out Above and Push Out Below determine the Left and Right 
margins for text fields above and below the box. Text fields inside the box are always inside 
the left and right sides of the box (the distance inside being determined by the Left and 
Right margins). Text fields above and below the box normally use the same Left and Right 
margins, but if the corresponding checkbox is selected instead regard the outer edge of the 
box as the left and right margins. The actual placement of text fields still depends on the 
horizontal alignment selected in the Edit Layout dialog.

Size Control

Box size calculation is by default automatic: box size being the space needed for the text 
plus margins. You can optionally specify a minimum height and/or width for a box. If you 
specify both a minimum height and a minimum width, you can also select that these 
settings amount to a fixed aspect ratio, which means that boxes using this Layout will 
always have the same height to width ratio.

Two examples:

To make rectangular box shapes square, or elliptical box shapes circular, select a minimum 
height and width of zero, and select Fixed Ratio. Since the minima specified are zero, there is
effectively no minimum size to a box, but they will always be square (or circular) since the 
ratio is 1:1.

To force boxes to be 5x3, and have a minimum width of 2.5cm, select a minimum width of 
2.5cm and a minimum height of 1.5cm, and select Fixed Ratio.

Selecting a fixed aspect ratio for a box affects the behaviour of any size-matching rules you 
may specify for the chart. See Match Box Sizes dialog box for details.



Box Spacing dialog box

This dialog allows you to specify the various Layout factors affecting the spacing of boxes.

Note that the title bar of the Box Spacing dialog always contains the name of the Layout 
being edited.

When calculating the relative positions of a box using this Layout and its subordinates, up to 
six
distances can be specified, though not all distances are used for every style and alignment.

See Entering Measurements for details of entering measurements.

See also Keys for working with dialog boxes.

Two examples illustrate the use of all distances:

For styles resulting in subordinates being placed across

Key: A Minimum Distance between this box and subordinates
B Minimum Horizontal Distance between subordinates
C Offset Distance between this box and subordinates
D Vertical Stem Distance

The Minimum Vertical Distance between subordinates is always ignored.

The Horizontal Stem Distance is used only if a subordinate is marked as an Assistant. It is 
then used to determine both how far from the common connector to position the Assistant, 
and the distance between Assistants.

The Offset Distance is used only when certain Connections Styles are selected. Styles using 
the Offset Distance are indicated by a solid box in the pictorial Styles list.

The Vertical Stem Distance is ignored for Connections Styles that have no common 
connector portion.

Note: The Vertical Stem Distance must be less than or equal to the Minimum Distance 
between this box and its subordinates. In other words, the horizontal connecting line in an 
Organization Chart (for example) must be positioned somewhere between the bottom of this
box and the top of the subordinate boxes.



For styles resulting in subordinates being placed down

Key: A Minimum Distance between this box and subordinates
B Minimum Vertical Distance between subordinates
C Offset Distance between this box and subordinates
D Horizontal Stem Distance

The Minimum Horizontal Distance between subordinates and the Vertical Stem Distance are 
always ignored.

The Offset Distance is used only when the Offset Left or Offset Right alignments are 
selected, and it is the horizontal distance to the point where the connecting line emerges 
from this box.

The Horizontal Stem Distance is also used if a subordinate is marked as an Assistant. It is 
then used to determine both how far from the common connector to position the Assistant, 
and the distance between Assistants.

The Offset Distance is used only when certain Connections Styles are selected. Styles using 
the Offset Distance are indicated by a solid box in the pictorial Styles list. It then represents 
the horizontal distance to the point where the connecting line emerges from this box.



Default Layouts dialog box

This dialog allows you to specify which Layout is initially used by a newly-inserted box.    You 
can specify a different Default Layout for each level in your chart.

The Default Layout for a particular level is determined as a two-step process:

1. If there is a specific Layout named as Default for this level, use it

2. If there is no specific Layout named for this level, use a chart-wide default.

The chart-wide default can be selected from the Default drop-down list.

Defaults for specific levels can be selected from the level-specific drop-down lists. If you 
don't want to name a specific Layout as default for a level, just select '(default)' in the list.

Only eight levels can have defaults specified, any boxes inserted at levels nine and above 
will always use the chart-wide default. You'll find that in practise very few charts will have 
greater than eight levels.

Choose the OK button to complete the dialog and implement the changes you
have made. Choose the Cancel button to abandon the dialog, leaving your Default Layouts 
unchanged.

See also Keys for working with dialog boxes.



Delete Unused Layouts dialog box

This dialog allows you to delete any Layouts you no longer need.

TreeChart will not allow you to delete Layouts that are being used. Only unused Layouts can 
be deleted. If a Layout is named as a Default Layout, it is considered to be in use, even if no 
box is actually using it.

All currently unused Layouts are listed. Select the Layout(s) you wish to delete.

Choose the OK button to complete the dialog, and delete all selected Layouts.
Choose the Cancel button to abandon the dialog, leaving layouts untouched.

See also Keys for working with dialog boxes.



Chart menu commands

The Chart menu offers the following commands:

Define Fields Define box text fields.
Border Fields Define Border text fields.
Border Text Edit the Border text.
Border Layout Change the Border Layout.
Border 
Margins

Change the Border margins.

Match Box 
Sizes

Change the box size-matching rules.

Page Setup Change page margins and print style.



Define Text Fields command (Chart menu)

Use this command to add a new text field or rename or delete an existing text field. All 
boxes in a chart have the same number of text fields.

TreeChart displays the Define Text Fields dialog box.    

Shortcuts
Keys: F3



Define Border Text Fields command (Chart menu)

Use this command to add a new Border text field or rename or delete an existing Border text
field. Border text fields are independent of box text fields.

TreeChart displays the Define Text Fields dialog box.    

Shortcuts
Keys: SHIFT+F3



Edit Border Text command (Chart menu)

Use this command to edit Border text.

TreeChart displays the Edit Text Fields dialog box.

Shortcuts
Mouse: double click on chart background
Keys: F7



Border Layout command (Chart menu)

Use this command to change the appearance of the Border.

TreeChart displays the Edit Border Layout dialog box.

Shortcuts
Mouse: SHIFT+double click on chart background
Keys: SHIFT+F7



Border Margins command (Chart menu)

Use this command to change the margins of the Border.

TreeChart displays the Border Margins dialog box.

Shortcuts
Keys: CTRL+F7



Match Box Sizes command (Chart menu)

Use this command to change the rules for matching box sizes throughout the chart.

TreeChart displays the Match Box Sizes dialog box.



Page Setup command (Chart menu)

Use this command to change the margins used when printing, and whether TreeChart should
print your chart at its correct size or shrink it to fit on a single page.

TreeChart displays the Page Setup dialog box.



Define Text Fields dialog box
Define Border Text Fields dialog box

These dialog boxes allow you to change the text fields available within boxes or the Border.

You can build up a series of changes to the text fields, then proceed to alter the chart or 
cancel the changes.

See also Keys for working with dialog boxes.

To Rename an existing Field:

1 Select the existing Field you wish to rename
2 Enter the new name of the Field in the New Name control
3 Choose the Rename button

The Rename button is only enabled when text has been entered in the New Name control, 
and one Field has been selected.

Field Names must be unique, and an error message is shown if you attempt to rename a 
Field to using Name which is already in use

To Add a new Field:

1 Enter the name of the Field you wish to add in the New Name control
2 Choose the Add button

The Add button is only enabled when text has been entered in the New Name control.

Field Names must be unique, and an error message is shown if you attempt to add a Field to 
using an Name which is already in use.

To Delete an existing Field:

1 Select the Field (or Fields) you wish to delete
2 Choose the Delete button

The Delete button is only enabled when at least one Field has been selected, and when no 
text has been entered into the New Name control.

Any number of Fields can be deleted in one operation by selecting a group of Field Names.

Completing the dialog:

After changing the Field definitions, choosing the OK button causes the changes to be 
applied to your chart.

Choosing the Cancel button cancels the dialog leaving your chart unchanged.

Box Text Fields:



For newly added Fields, all boxes and Layouts will have the Field added. Box text for this 
Field will initially be empty, and the Field will initially be hidden. You will need to edit each 
Layout in which you want the Field to be visible.

For deleted Fields, all boxes and Layouts will have the Field deleted.

Border Text Fields:

For newly added Fields, text for this Field will initially be empty, and the Field will initially be 
visible. You will need to edit the Border Layout if the default font or position of newly added 
Border Fields is not as you wish.



Edit Border Layout dialog box

This dialog allows you to change every aspect of the Border's appearance, and provides 
immediate feedback on the effects of any changes you make. Feel free to try various 
combinations of options; you can always cancel the changes if you want.

The sample providing feedback uses the Border Text Field Names to indicate Field position & 
appearance. When the Border Layout is subsequently used as the chart is drawn, the size of 
the chart plus Border is determined by further factors, such as Border Margins and Page 
Setup options.

See also Keys for working with dialog boxes.

Text Controls

This group of controls allows you to change all options affecting how text appears:

- Which Border Text Fields are visible
- Vertical placement
- Horizontal alignment
- Font, size & color

All the text controls affect only the Text Field selected in the drop-down list of Field Names. 
You must first select the Field you wish to change. The first defined Border Text Field is 
always selected automatically when you commence this dialog.

The Hide checkbox determines whether the selected Field is visible or hidden. If the Field is 
hidden, all other text controls are disabled, since it seems unwise to change options you 
can't see the effect of, and will have no effect if modified.

The Font button causes a font selection dialog to appear. This allows not only the facename 
and size to be selected, but also the color and a number of effects (like underline).

The Horizontal Alignment list allows the selected Field to be positioned horizontally within 
the box: Left-aligned, Centered or Right-aligned.

The Vertical Alignment list allows the selected Field to be positioned vertically with respect
to the box: Above the box, Top-aligned, Bottom-aligned or Below the box. Unlike box text 
fields, Border text fields cannot be centered vertically; this space is reserved for your chart.

Note that the various margins affecting the Horizontal & Vertical position are defined by the 
Margins button in the group of controls affecting the border itself.

The Up & Down buttons move the selected Field up & down. When a Field swaps order with 
a Field with a different Vertical alignment, the Vertical Alignment of this Field is automatically
updated to reflect this. These buttons are disabled when the selected Field can't go any 
further up (or down).

Border Controls

This group of controls allows you to change all options affecting how the border itself 
appears:

- The border shape



- Drop-shadow direction, depth & color
- Line width & color
- Internal color
- Margins

The Border Shape list allows you to choose the shape of the border.

The Margins button presents the Border Margins dialog, which allows you to change the 
distances between the border and its text fields, and the border and your chart.

The Shadow list allows you to choose a drop-shadow style (including no shadow). You can 
choose from three shadow depths in each of four directions.

The Line Width list offers a number of preset border line widths (including no Border).

The Colors group of buttons all present an identical color selection dialog. to allow you to 
choose a Border, Background or Shadow color.

The Fixed Background Color checkbox determines how the chart background should be 
treated under certain outlining conditions. If this checkbox is selected, the Border 
Background color you choose will always be used. If this checkbox is clear, the chart 
background color may change as you change your outlining selections. See the chart 
background color for more details.



Border Margins dialog box

This dialog allows you to specify the various Layout factors affecting the relative positioning 
of your chart and the Border text fields within the Border.

See Entering Measurements for details of entering measurements.

See also Keys for working with dialog boxes.

The Border Margins specify the minimum distance between your chart and the border, and 
the absolute distance between the border and the Border Text Fields.

When adding the Border to your chart, the margins are interpreted in two different ways:

When copying a picture of your chart to the Clipboard, or saving as a picture-format file, the
Border (and Border Margins) are added to your chart. The picture will always be bigger than
your chart; the extra area being the Border.

When printing your chart, the Page Margins are subtracted from the paper size to determine
where the Border is. The Border Margins are then also subtracted to leave an area of paper
available for the chart itself; what happens then depends on what printing style (poster or 
fit-
to-page) you have selected.

The meaning of the eight margins is illustrated by the following diagram:

Text fields having the same vertical alignment always have single line spacing.

The Above, Below, TopMiddle and BottomMiddle margins are only used if there are text fields
above, below, top or bottom vertically aligned respectively. If this is not the case, these 
margins are totally ignored.

The checkboxes Push Out Above and Push Out Below determine the Left and Right 
margins for text fields above and below the border. Text fields inside the border are always 
inside the left and right sides of the border (the distance inside being determined by the Left
and Right margins). Text fields above and below the border normally use the same Left and 
Right margins, but if the corresponding checkbox is selected instead regard the outer edge 
of the border as the left and right margins. The actual placement of text fields still depends 
on the horizontal alignment selected in the Edit Border Layout dialog.





Match Box Sizes dialog box

While the size of individual boxes is determined by the text that they contain, and Layout 
options like Fonts & Box Size, TreeChart also offers a variety of options for matching box 
sizes.

See also Keys for working with dialog boxes.

The height and width of boxes can be controlled independently; select one radio button from
each group:

Independent No further size corrections are applied.
Equal Throughout Chart All Boxes will be drawn the same size.
Equal Within Levels All Boxes at the same level will have the same 

size.
Equal Among 
Subordinates

All Boxes having the same Parent will have the 
same size.

Equal Using Layouts All Boxes using the same Layout will have the 
same size.

You can also mark specific boxes to be ignored when matching heights or widths. See 
Marking Boxes as Exceptions to the Rules.

Wherever box sizes are changed, they are always increased to match the size of the largest 
box in the chosen category.

All boxes using the same Layout implicitly have the same height. The height of a box is 
determined by which fields are present, their font sizes and the box margins; it is not 
determined by the height of the actual text in the fields.

Deciding what boxes are compared

The radio buttons selecting the scope of the scan for size matching is useful when outlining 
facilities are in use. Matching box sizes within the Current View produces the most attractive 
individual charts. Matching box sizes throughout the whole chart is useful when you want 
consistent box sizes over a set of sub-charts prepared using outlining.

Select Current View to make boxes match the largest visible box.

Select Entire Chart to make boxes match the largest box in the entire chart.

Size matching rules and fixed-ratio boxes

In the Box Size dialog, you can specify a fixed height to width ratio for boxes using a Layout. 
This interferes with the strict appliance of size matching rules. In these circumstances, the 
approach taken by TreeChart is for the height of such a box to obey the size matching rules, 
and the width of the box to then be re-calculated to obey the aspect ratio rule.



Page Setup dialog box

This dialog allows you to specify how TreeChart fits your chart and its Border to sheets of 
paper when printing.

Margins

The margins specify the distance from the edge of the paper to the center of the border.

To change the margins between the border and the Border text fields, or between the 
border and your chart, use the Border Layout command.

See Entering Measurements for details of entering measurements.

Print Style

Select Poster to print your chart at its actual size. If the chart doesn't fit on a single sheet
of paper, it will be printed on a series of sheets which you must then stick together.

Select Fit To Page to print your chart on a single sheet of paper. TreeChart automatically 
shrinks all box and font sizes in proportion to make the chart fit.

See also Keys for working with dialog boxes.



Entering Measurements

A number of dialogs within TreeChart permit you to enter absolute measurements (margins, 
for example).    Entering measurements is handled in a consistent fashion:

Measurements can be presented in either metric or imperial units (centimetres or inches).

All dialogs containing measurements offer radio buttons to select the units the 
measurements are to be presented in.    All measurements within a dialog are presented in 
the same units.

When a dialog containing measurements appears, the units will be as you last selected 
them. The units on program startup are read from an initialisation file, and will be as you last
selected them last time the program was run.    If the units cannot be read from the 
initialisation file, the program uses the units specified by the International section of the 
Windows Control Panel.

The number of decimal places used when measurements are presented is as selected in the 
International section of the Windows Control Panel.

The decimal separator used when measurements are presented is as selected in the 
International section of the Windows Control Panel.    This decimal separator must also 
be used when you enter measurements.

You can enter measurements in a variety of units, for example:

3 in 4.25" 2.1 cm 15mm 72pt (points) 16pi (pica)

Spaces between number and units are ignored. If no units are specified, the current 
presentation units (centimetres or inches) are assumed.

All measurements used by TreeChart must be in the range 0"-22" approximately. Attempting 
to enter values outside this range results in an error message when you change presentation
units or complete the dialog.



Chart Window Mouse Operations

TreeChart only uses the left button on the mouse, or the right button if the mouse buttons 
have been reversed by settings in the Windows Control Panel.

Quick summary of standard Windows mouse techniques:

Click move the mouse
press & release the left mouse button

Double-Clickmove the mouse
quickly press & release the left mouse button twice

Drag move the mouse
press (and hold down) the left mouse button
move the mouse
release the left mouse button to complete the operation

Click & double-click behaviour largely depends on whether or not the mouse pointer is over 
a box when you press the mouse button. When you're pointing at a box, the cursor changes:

pointer on a box

pointer on the chart background

Inserting a new box:

You can insert a new box by dragging from an existing box:

1 Move the mouse over the box you want to insert above, below, left of or right of.

2 Press (and hold down) the left mouse button. This is called the Start Position.

3 Move the mouse. Depending on the distance from the Start Position, and the position 
relative to the Start Position, the mouse cursor will change:

Near Start Position - abandon insert

Above Start Position - Insert box above existing 
box

Below Start Position - Insert box below existing 
box

Left of Start Position - Insert box left of existing 
box

Right of Start Position - Insert box right of existing 
box

4 Release the left mouse button to complete the operation, the action taken depends 
on the cursor that was shown when you release the button.

See also Inserting Boxes.



Summary of Chart Window Operations:

To with the mouse

Move Insertion Point click on box
Edit box Text Fields double-click on box
Edit Layout used by box SHIFT+double-click on box

Edit the Border Text double-click on chart background
Edit the Border Layout SHIFT+double-click on chart background

Insert a box in an empty chart or 
view

drag on chart background

Insert a box above existing box drag up from existing box
Insert a box below existing box drag down from existing box
Insert a box left of existing box drag left from existing box
Insert a box right of existing box drag right from existing box
Abandon box insertion drag back to starting point

Toggle box selection status CTRL+click on box
Clear Selections click on chart background
Select a group of boxes drag selection rectangle on chart background
Add a group of boxes to current 
selection

CTRL+drag selection rectangle on chart 
background

Note: The last two operations automatically scroll the chart window to keep the cursor 
visible.



View menu commands

The View menu offers the following commands:

Toolbar Show or hide the Toolbar.
Status Bar Show or hide the Status Bar.
View All Show all boxes, by removing Focus & expanding collapsed boxes.
Focus Focus on Sub-Tree or the whole chart.
Collapse Collapse selected boxes, making boxes below them hidden.
Expand Expand selected boxes, revealing hidden boxes.
Expand All Expand all collapsed boxes, revealing hidden boxes.
Zoom In Zoom in, to magnify a portion of the chart.
Zoom Out Zoom out, to see more of the chart.
Zoom Normal Restore to 100% zoom.

View All command (View menu)

Use this command to remove all outlining selections you have made, and view the entire 
chart.

Focus is restored to the whole tree, and all collapsed boxes are expanded.

Shortcuts

Toolbar:
Keys: CTRL+Q

See Outlining for an overview of outlining commands.



Focus command (View menu)

Use this command to focus on one sub-tree of your chart, and hide all boxes not on that sub-
tree.

This command switches between focussing on the whole tree and any sub-tree. When you 
are focused on a sub-tree, the menu item has a check mark beside it. Selecting this 
command again restores focus to the whole tree.

When focus is applied, the Current Box, and all boxes below it remain visible. All other boxes 
are hidden.

The Focus command can affect the Chart Background Color.

Shortcuts

Toolbar:
Keys: CTRL+F

See Outlining for an overview of outlining commands.



Collapse command (View menu)

Use this command to hide some of the detail of your chart. The command collapses the 
selected boxes; all boxes below these become hidden.

See Selecting Boxes for a summary of the commands to select boxes.

Shortcuts

Toolbar:
Keys: CTRL+K

See Outlining for an overview of outlining commands.



Expand command (View menu)

Use this command to reveal boxes hidden using the Collapse command. This command 
expands the selected boxes; all boxes below these are revealed.

See Selecting Boxes for a summary of the commands to select boxes.

You may have previously collapsed some of the revealed boxes. These boxes will remain 
collapsed unless you expand them. To expand all boxes use the Expand All command.

Shortcuts

Toolbar:
Keys: CTRL+E

See Outlining for an overview of outlining commands.



Expand All command (View menu)

Use this command to reveal boxes hidden using the Collapse command. This command 
expands all collapsed boxes, revealing all hidden boxes.

Shortcuts

Toolbar:
Keys: CTRL+SHIFT+E

See Outlining for an overview of outlining commands.



Outlining

Outlining is the technique offered by more sophisticated word processors to allow you to 
hide parts of a document, and concentrate on other parts.

For example, this describes the structure of a simple document:

The Document
Chapter 1

Section 1
Section 2

Sub-section 1
Sub-section 2

Chapter 2
Section 1
Section 2

Showing the document in this form already illustrates one aspect of outlining: hiding the 
actual text within each section or sub-section, and just concentrating on the section 
headings. This will have been achieved by using a command to collapse the sections.

If you wanted to edit the text within Chapter 1, Section 1, this heading would be expanded 
to show the text beneath it.

Another example of outlining that you may be familiar with is the directory windows of the 
Windows File Manager.

TreeChart offers outlining to perform much the same function: hiding some aspects of your 
chart, and allowing you to better concentrate on other aspects.

The example document we described above could be shown in TreeChart terms like this:

If you just wanted to have a 'top-level' view of the chart, you could select the two 'Chapter' 
boxes, then use the Collapse command. The chart would be redrawn like this:

Notice that when recalculating the box positions, the 'Chapter' boxes are now placed much 
closer together. Box placement depends only on visible boxes, so that the chart looks 
attractive whatever outlining selections you have chosen.

In an Organization Chart, Collapse is useful for viewing management, and hiding other staff.

You reveal whatever's hidden below collapsed boxes by expanding them. Two commands do 
this: the Expand command expands the selected boxes, while the Expand All command 



expands all collapsed boxes.

As well as hiding things below a box, TreeChart also allows you to hide things above a box. 
Returning to the original chart, we can focus our attention on Chapter 1 by making the 
'Chapter 1' box the Current Box, then using the Focus command. The chart would be 
redrawn like this:

In saying that this hides all boxes above the Current Box, we're being a bit inaccurate; what 
the Focus command really does is leave only the Current Box and all boxes below it visible; 
all boxes above it or on different branches are hidden.

In an Organization Chart, Focus is useful for viewing just one department, and hiding all 
others.

You can only focus on one box at a time. When you are focusing on a box, a mark is 
displayed beside the command name on the View menu. To remove the focus, and reveal 
the true top-level box, choose the command again.

If the box you have focused on 'disappears', the focus is automatically moved to the parent 
of the box that had the focus. This is done to ensure that you can always see the context 
you're working in. A box can 'disappear' in two ways: by being deleted, or if you collapse a 
box marked as Invisible.

The Focus & Collapse commands can be combined. For example, you might wish to focus
on Chapter 1, and then collapse the Section boxes to give you this:

The View All command removes focus and expands all collapsed boxes.

See Keys for hiding boxes (outlining) for a summary of keyboard shortcuts for outlining 
commands.

The Current View

The outlining selections you make define the Current View of the chart.

Wherever sensible, commands you select are always performed on the Current View. For 
example, the Select All command selects all boxes in the Current View.

The only operations that are always performed on the whole chart, rather than the Current 
View are:

1 Saving the chart (in TreeChart format or Text format)
2 Adding, deleting or renaming a box Text Field

Working with the Current View rather than the whole chart is particularly useful when you 
need to output the finished chart: if you print, copy a picture to the Clipboard or save a 
picture-format file, it is always the Current View.



The Current View is not saved with a chart - when you open a chart, you will see the whole 
chart until you choose otherwise.

See also the Chart Background Color.



Zoom In command (View menu)

Use this command to increase the zoom factor used when your chart is displayed.

Zoom factors greater than 100% cause boxes to be displayed larger than when they are 
printed, making small text sizes easier to read.

This command is ignored if the zoom factor is already at its maximum value.

The zoom factor can be set to a specific value by using the Toolbar.

Shortcuts
Keys: +

See Zooming Chart Display for an overview of zooming commands.



Zoom Out command (View menu)

Use this command to decrease the zoom factor used when your chart is displayed.

Zoom factors less than 100% cause boxes to be displayed smaller than when they are 
printed, allowing you to see more boxes at once, though text becomes unreadable.

This command is ignored if the zoom factor is already at its minimum value.

The zoom factor can be set to a specific value by using the Toolbar.

Shortcuts
Keys: -

See Zooming Chart Display for an overview of zooming commands.



Zoom Normal command (View menu)

Use this command to restore the zoom factor to 100%. The displayed size of boxes will now 
match the printed size.

Shortcuts
Keys: =

See Zooming Chart Display for an overview of zooming commands.



Zooming the Chart Display

TreeChart normally displays your chart at full size. You can elect to display the chart with 
various
scaling or zoom factors, to see more of the structure of the chart (but with illegible text) or 
more
clearly see small text sizes (but fewer boxes).

All methods for moving around and editing your chart are available whatever the zoom 
factor. At small Zoom factors box shadows are not displayed since they tend to clutter up the
chart.

The current zoom factor (for the active chart) is indicated on the Toolbar.

The zoom factor is not saved with a chart - when you open a chart, the chart window will be 
at normal (100%) zoom factor until you choose otherwise.

To restore normal (100%) zoom:

Use the Zoom Normal command.

To set a specific zoom factor:

A specific zoom factor can only be set if the Toolbar is shown. To set a specific zoom factor, 
open the drop-down list on the Toolbar, and select the desired zoom factor. Keyboard users 
can access this list:

F2 Opens the list
arrow keys change selection
ENTER confirm selection (closes list)

To increment or decrement the zoom factor:

Use the Zoom In or Zoom Out commands.

These commands move to the next preset zoom factor. They are ignored if you are already 
displaying the chart at maximum / minimum zoom.



The Chart Background Color

The Background color you select for the Border is the background color for the chart. To assist you in 
selecting complimentary colors for the boxes, lines and text in your chart, this background color is used 
for the chart window, and for the sample in the Edit Layout dialog box.

Some of the box positioning styles cause boxes to be framed by other boxes. The background color of the
framed boxes is therefore the Fill color of the framing box.

If you use outlining techniques to Focus on a framed box, and hide all boxes above it and on different 
branches, you might want to temporarily adopt the framing box's Fill color as the chart background color, 
rather than continue to use the Border Background color. You can do this in the Edit Border Layout 
dialog box.

Subject to differing color capabilities of the various devices, the colors you see in the chart window are the
colors that will be used if you copy a picture to the Clipboard, save in picture format or print the chart.



Edit menu commands

The Edit menu offers the following commands:

Undo Undo the last insertion or deletion.
Cut Deletes boxes from the chart and moves them to the clipboard.
Copy Copies boxes from the chart to the clipboard.
Paste Below Pastes boxes from the clipboard into the chart below the Current Box.
Paste Left Pastes boxes from the clipboard into the chart to the left of the 

Current Box.
Paste Right Pastes boxes from the clipboard into the chart to the right of the 

Current Box.
Insert Above Insert a new box above the Current Box.
Insert Below Insert a new box below the Current Box.
Insert Left Insert a new box to the left of the Current Box.
Insert Right Insert a new box to the right of the Current Box.
Box Text Edit the text within the Current Box.
Mark Boxes Change the markers of the selected boxes.
Delete Delete selected boxes.
Swap Swaps the positions of two boxes.
Select All Selects all boxes.
Select Sub-Tree Selects the Current Box and all boxes below it.
Select Level Selects all boxes at the same level as the Current Box.
Select 
Subordinates

Selects all boxes immediately below the Current Box.

Select Marked Selects boxes dependent on their marker settings.
Clear Selections De-selects all selected boxes.

Undo command (Edit menu)

Use this command to reverse the last editing action, if possible.      The name of the 
command changes, depending on what the last action was.

You can only undo box insertions and box deletions.

The Undo command is disabled if you cannot reverse your last action.

Shortcuts
Keys: CTRL+Z or

ALT-BACKSPACE



Cut command (Edit menu)

Use this command to remove the currently selected boxes from the chart and put them on 
the clipboard.    If no boxes are selected, the Current Box is cut.

Cutting data to the clipboard replaces the contents previously stored there.

If you make a mistake, you can undo the box deletion caused by this command (but you 
cannot undo the change to the clipboard).

See Selecting Boxes for a summary of commands for selecting boxes.

See exchanging information between charts for further information on cutting boxes and 
pasting them into a different chart.

See exchanging information between programs for further information on using the 
Clipboard to transfer information between TreeChart and other programs.

Shortcuts

Toolbar:
Keys: CTRL+X or

SHIFT+DEL



Copy command (Edit menu)

Use this command to copy selected boxes onto the clipboard.    If no boxes are selected, the 
Current Box is copied.

Copying data to the clipboard replaces the contents previously stored there.

See Selecting Boxesfor a summary of commands for selecting boxes.

See exchanging information between charts for further information on copying boxes and 
pasting them into a different chart.

See exchanging information between programs for further information on using the 
Clipboard to transfer information between TreeChart and other programs.

Shortcuts

Toolbar:
Keys: CTRL+C or

CTRL+INS



Paste Below command (Edit menu)

Use this command to insert a copy of the clipboard contents below the Current Box.    This 
command is unavailable if the clipboard is empty.

If you Paste below a box that has subordinates, all those subordinates are 'demoted' and 
become
subordinates of the pasted box. In Organization Chart terms, pasting a box below a manager
creates a new middle manager position.

If you make a mistake, you can undo this command.

See exchanging information between charts for further information on pasting boxes that 
were copied from a different chart.

See exchanging information between programs for further information on using the 
Clipboard to transfer information between TreeChart and other programs.

Shortcuts

Toolbar:
Keys: CTRL+V or

SHIFT+INS



Paste Left command (Edit menu)

Use this command to insert a copy of the clipboard contents to the left of the Current Box.    
This command is unavailable if the clipboard is empty.

If you make a mistake, you can undo this command.

See exchanging information between charts for further information on pasting boxes that 
were copied from a different chart.

See exchanging information between programs for further information on using the 
Clipboard to transfer information between TreeChart and other programs.

Shortcuts
Keys: CTRL+L



Paste Right command (Edit menu)

Use this command to insert a copy of the clipboard contents to the right of the Current Box.   
This command is unavailable if the clipboard is empty.

If you make a mistake, you can undo this command.

See exchanging information between charts for further information on pasting boxes that 
were copied from a different chart.

See exchanging information between programs for further information on using the 
Clipboard to transfer information between TreeChart and other programs.

Shortcuts
Keys: CTRL+R



Insert Above command (Edit menu)

Use this command to create a new box, placing it immediately above the Current Box.

The new box will initially use the Default Layout for the level it has been inserted at.

The Current Box and all boxes below it will be moved down one level.

If you make a mistake, you can undo this command.

See inserting boxes for further information on inserting boxes.

Shortcuts
Mouse: drag up from Current Box
Keys: ALT+UP



Insert Below command (Edit menu)

Use this command to create a new box, placing it immediately below the Current Box.

The new box will initially use the Default Layout for the level it has been inserted at.

If you insert a new box below a box that has subordinates, all those subordinates are 
'demoted' and become subordinates of the newly-inserted box. In Organization Chart terms, 
inserting a box below a manager creates a new middle manager position.

If you make a mistake, you can undo this command.

See inserting boxes for further information on inserting boxes.

Shortcuts
Mouse: drag down from Current Box
Keys: ALT+DOWN



Insert Left command (Edit menu)

Use this command to create a new box, placing it immediately to the left of the Current Box.

The new box will initially use the Default Layout for the level it has been inserted at.

If you make a mistake, you can undo this command.

See inserting boxes for further information on inserting boxes.

Shortcuts
Mouse: drag left from Current Box
Keys: ALT+LEFT



Insert Right command (Edit menu)

Use this command to create a new box, placing it immediately to the right of the Current 
Box. 

The new box will initially use the Default Layout for the level it has been inserted at.

If you make a mistake, you can undo this command.

See inserting boxes for further information on inserting boxes.

Shortcuts
Mouse: drag right from Current Box
Keys: ALT+RIGHT



Box Text command (Edit menu)

Use this command to edit the text in the Current Box. TreeChart displays the Edit Text dialog 
box.    

Shortcuts
Mouse: double click on box
Keys: ENTER



Delete Boxes command (Edit menu)

Use this command to delete the selected boxes. If no boxes are selected, the Current Box is 
deleted.

If you delete a box that has subordinates, but don't delete the subordinates themselves, the 
subordinates are 'promoted'.

If you make a mistake, you can undo this command.

See Selecting Boxesfor a summary of commands for selecting boxes.

Shortcuts
Keys: DEL



Swap Positions command (Edit menu)

Use this command to swap the positions of two sub-trees.

This command is only available if two boxes are selected, and they have the same parent.

See Selecting Boxesfor a summary of commands for selecting boxes.

Shortcuts
Keys: CTRL+W



Select All command (Edit menu)

Use this command to select all boxes in the Current View.

See Selecting Boxesfor a summary of commands for selecting boxes.

Shortcuts

Toolbar:
Keys: CTRL+A



Select Sub-Tree command (Edit menu)

Use this command to select the Current Box, and all visible boxes below it.

See Selecting Boxesfor a summary of commands for selecting boxes.

Shortcuts

Toolbar:
Keys: CTRL+T



Select Level command (Edit menu)

Use this command to select all visible boxes at the same level as the Current Box.

See Selecting Boxesfor a summary of commands for selecting boxes.

Shortcuts

Toolbar:
Keys: CTRL+H



Select Subordinates command (Edit menu)

Use this command to select all boxes immediately below the Current Box.

See Selecting Boxesfor a summary of commands for selecting boxes.

Shortcuts

Toolbar:
Keys: CTRL+I



Clear Selections command (Edit menu)

Use this command to de-select all selected boxes.

See Selecting Boxesfor a summary of commands for selecting boxes.

Shortcuts
Mouse: click on chart when not over a box
Keys: CTRL+G



Edit Text dialog box
Edit Border Text dialog box

Text Fields, and their associated text are presented as a table. The number of Fields, and 
their names, will depend on what Text Fields you have defined for the boxes or the Border of 
your chart.

Only the associated text can be changed, not the Field names or the number of Fields. To 
modify Box Text Field names, use the Define Text Fields dialog box. To modify Border Text 
Fields, use the Define Border Text Fields dialog box.

Movement around the table is similar to a spreadsheet. Note that the TAB key circulates the 
focus between the table, the OK button and the Cancel button. To move around the table, 
use the arrow keys (or, with the mouse, click on a cell).

Individual table cells act like normal single line edit controls. One consequence of this is that 
you can only copy and paste individual Fields (not a group of Fields).

To Press

Copy selected text CTRL+C
Cut selected text CTRL+X
Paste text CTRL+V

Pasting text from other programs can result in TAB characters being placed in your text. 
These are shown in this dialog as a vertical bar, indicating a non-displayable character. 
When you complete the dialog, TreeChart converts each TAB to a single space.



Selecting Boxes

Some TreeChart commands (for example, edit text) can only meaningfully operate on one 
box at a time. These commands always work on the Current Box.

Other TreeChart commands (for example, delete boxes) can work on a set of boxes 
simultaneously. These commands will work on the selected boxes, or if no boxes are selected
the Current Box.

Selected boxes are shown on the display by being drawn inverted; white boxes becoming 
black, for instance.

There are four basic methods of selecting boxes:

individually,
by region,
by position,
or depending on their marker settings

By combining these techniques, an arbitrary set of selected boxes can quickly be defined.

See Keys for selecting boxes for a summary of keyboard shortcuts for selecting boxes.

Use the Clear Selections command to de-select all selected boxes.

Selecting Individual boxes

To toggle the selection status of the Current Box

Mouse Keyboard

Move the cursor over the box. Press SPACE
Click the left mouse button
while holding down CTRL

This is just like performing multiple selections in a list box (for example, selecting a group of 
files in Windows File Manager).

Selecting a group of boxes by region

This can only be done with a mouse. If you press (and hold down) the left mouse button 
while not
over a box, then start to drag, a dotted rectangle will be drawn to indicate the selection 
region.
Releasing the mouse button completes the operation. All boxes entirely within the selection 
region will be selected. If you move the mouse cursor outside of you chart window during 
this operation, the window automatically scrolls.

The first box in the selection region becomes the Current Box.

If you hold down CTRL as you commence the selection, current selections are retained, and 
boxes within the selection region are added to the set of selected boxes. If you do not hold 
down CTRL, current selections are cleared before selecting the boxes within the selection 
region.



Selecting a group of boxes by position.

Four menu / toolbar commands let you select a group of boxes:

Toolba
r

Edit Menu

Select All Select all boxes.
Select Level Select all boxes at the same level as the Current 

Box.
Select Subord Select all boxes directly below the Current Box.
Select Sub-
Tree

Select Current Box, and all boxes below it.

These commands always add more selections. To remove any existing selections before 
selecting a new group,    use the Clear Selections command.

Selecting a group of boxes depending on their marker settings

TreeChart allows you to mark boxes as exceptions to the rules. With the Select Marked 
command, you can select boxes depending on their marker settings.

See Marking Boxes for an overview of marking boxes.



Moving around a chart

Working with chart windows is much like working with a document window in any Windows 
application.

The caret indicates the Current Box.

Moving the caret is much like the Insertion Point in a word processor:

With a mouse: click on a box.

Keyboard: See Keys for moving the caret.

If you are using a mouse, a number of operations automatically make the box you're 
pointing at the Current Box as part of the operation.

If the Current Box is changed, the chart window is automatically scrolled to make the Current
Box visible.

See also Keys for scrolling a chart window for a summary of keyboard shortcuts for scrolling 
a chart window without moving the caret.



Exchanging information between charts

When TreeChart copies (or cuts) boxes to the Clipboard, the information it saves in the 
Clipboard includes the name of the Layout used by each box, but not the actual Layout 
settings.

It works this way because its the most natural: if a number of boxes use the same Layout, 
pasted boxes will use exactly the same Layouts as they used before they were cut. If you 
happen to change the Layout settings after the cut command, but before the paste 
command, the pasted boxes will automatically use the new Layout settings (not the ones in 
force when the cut command was performed).

If you copy boxes from one chart to another, the Layouts used by these boxes might not be 
defined in the chart they're being pasted into. Alternatively, they might be defined, but with 
totally different settings.

What TreeChart does when pasting boxes is this: if a box uses a Layout whose name is 
defined in this chart, the box will use that Layout, otherwise it will use the Default Layout for
the level it has been inserted at.

This means that if you copy boxes from one chart to another, the pasted boxes will have the 
style / appearance appropriate for the chart being pasted into rather than the chart they 
were copied from.

At present, TreeChart offers no means to copy Layouts between charts.



Exchanging information with other programs

The Clipboard is a mechanism built into Windows to permit information to be exchanged 
between programs. This normally simply involves selecting some information in one 
program, Copying it to the Clipboard, starting or switching to the other program, selecting 
where the information is to be inserted, then Pasting the information. A further Clipboard 
operation Cut, is equivalent to Copy followed by Delete.

This powerful Windows feature relies on programs agreeing the format of information on the
Clipboard. TreeChart copies (or cuts) chart information in up to three different formats:

Native This format is principally for cut & paste within a chart or between two 
different TreeChart documents. The selected boxes (and references to 
the Layouts they use) are copied to the Clipboard, or if no boxes are 
selected, the Current Box.

Text This format would principally be used for exchanging information with 
a word processor or spreadsheet. No Layout or organizational 
information is copied. The text fields of the selected boxes are copied, 
or if no boxes are selected, the text fields of the Current Box.

Metafile This format is used for pasting a picture into a word processor 
document. TreeChart copies the entire current view (plus the Border) - 
box selections are irrelevant.

TreeChart always copies to the Clipboard in Native format. The use of Text & Metafile formats
is
controlled by means of the Preferences dialog.

Copying Text from another program into TreeChart

To a large extent, this works as you might expect. After giving a few examples, we'll describe
in more detail what's going on in the background, so that if you have any problems you 
might be able to work around them.

To copy text from Notepad (or similar editor / word processor):

In the Windows Notepad accessory, select the lines of text you want to copy. From the Edit 
menu, choose Copy.

Switch to the TreeChart chart window you wish to paste into.

Move the caret to select the Current Box. From the Edit menu, choose Paste Below, Paste 
Left or Paste Right, as necessary.

One new box will be created for each line of text you selected.

The conversion of each line of text into Text Fields depends on characters within the text. In 
the simplest case, any TAB character will be interpreted as a Text Field terminator, so if 
you're going to paste into a chart with four Text Fields defined, for the fastest results you 
should place three TAB characters in each line of text.

If TreeChart wasn't able to correctly identify the various Text Fields, you can either edit the 
Notepad document and repeat the operation, or (within TreeChart) call up the Edit Text 



dialog for each box, and cut & paste between fields.

To copy text from a Spreadsheet (or a table in Microsoft Word)

This is always simpler than copying text from an editor or word processor, since identifying 
boxes and Text Fields is almost foolproof.

In the Spreadsheet, select the range of cells you wish to copy. From the Edit menu, choose 
Copy.

Switch to the TreeChart window you wish to paste into.

Move the caret to select the Current Box. From the Edit menu, choose Paste Below, Paste 
Left or Paste Right, as necessary.

One new box will be created for each row copied, and each column corresponds to a Text 
Field.

Background information

In almost every Windows program, when you select a region of text then choose the Copy 
command, an unformatted version of that text will be copied to the Clipboard in addition to 
'richer' (formatted) versions that will be copied for the program's own use.

TreeChart always pastes this unformatted text into a chart. All subsequent formatting is 
determined by which Layout the resultant boxes use.

Each newly-created box initially uses the Default Layouts for the level it has been inserted 
at.

When pasting text from the Clipboard, TreeChart interprets the text as if it were opening a 
text file. It therefore automatically distinguishes between the various supported text 
formats.

Whatever text format is in use, TreeChart assumes that each line of text (terminated by a 
carriage return / line feed pair) constitutes a box, and text within that line is divided into 
fields which constitute TreeChart Text Fields.

If you're using another program purely to prepare TreeChart text, you might like to consider 
using
TreeChart Outline Text format. This enables you to specify (in the other program) the 
hierarchical organization of the boxes, and you can assign Layouts for each box to use. For 
example, in a spreadsheet, using TreeChart Outline Text simply requires adding one row and 
one column to your spreadsheet, and filling in the new cells.

Copying Text from TreeChart into another program

Select the boxes whose text you'd like to copy. From the Edit menu, choose Copy.

Switch to the program (and document window) you'd like to paste into, and position the 
insertion
point.

From the Edit menu, choose Paste.



Each TreeChart box will correspond to a line of text, with TAB characters separating the 
TreeChart Text Fields.

If you paste into a spreadsheet or word processor table, each box will correspond to a row, 
each text field to a column.

Note: TreeChart will only copy box information to the Clipboard in text format if the Copy as 
Text
option is selected in the Preferences dialog.

Copying Pictures from TreeChart into another program

From the Edit menu, choose Copy.

Switch to the program (and document window) you'd like to paste into, and position the 
insertion
point.

From the Edit menu, choose Paste. A picture of the chart will be inserted into the document

TreeChart copies pictures to the Clipboard in a format called Windows Metafile. Not all 
Windows
programs recognise this format, but most do. If you need to copy a picture into a program 
that doesn't recognise a Metafile, it might be possible to go through an intermediate 
program that can convert formats.

When drawing the chart to copy to the Clipboard, TreeChart adds the Border you have 
specified (just as if you were printing the chart). The Border Margins determine how much 
space to leave around the chart. The Page Setup margins are not used.

Note that Windows imposes a limit on the size of a picture you can copy to the Clipboard 
(about 11"). If the height or width of the chart is greater than this limit, TreeChart scales the 
drawing.

Note: TreeChart will only copy a picture to the Clipboard if the Copy as Picture option is 
selected in the Preferences dialog.

Changing picture size after pasting into another program

The Windows Metafile format allows the picture to be scaled (more or less) perfectly. In 
particular, the fonts used by text fields can be scaled along with the boxes.

One important point to note, however, is that the way the program receiving the picture 
performs
scaling determines whether or not everything in the picture is scaled proportionately. We'll 
illustrate this issue by describing one example; you may need to experiment with the 
specific programs that you are using to determine the best method of pasting pictures.

Resizing pictures with Word Processors and Drawing programs

If you want to paste a TreeChart picture into MS Word or the word-processor component of 
MS
Works, you can choose whether to paste directly into the document or insert a picture object
(to be edited with the MS Draw mini-application), and paste the picture into that object.



Pasting into an MS Draw object allows you to add text or lines to your chart, though of 
course
TreeChart will never know about any changes you make.

Whichever approach you take, if you want to resize the overall picture, you should do it 
from within the word processor itself, not from within Draw.

The reason for this is that the word processors treats the picture as a single entity. TreeChart
informed them how big it was, and they simply perform an overall scaling. MS Draw, on the 
other hand, understands the constituent parts of the picture, and if you re-size, you re-size 
each individual component. MS Draw doesn't resize text very well, though other drawing 
packages might manage it better.

Incidentally, after pasting a TreeChart picture into a Microsoft Word or Works (word 
processor)
document, you'll find that double-clicking on the picture allows you to edit the picture using 
the
Microsoft Draw mini-application. This is because these word processors support OLE (Object 
Linking and Embedding). The current version of TreeChart does not support OLE.

Maintaining proportions when resizing pictures

If you resize a picture produced by TreeChart, you should try to maintain the overall 
proportions. If you fail to do this, you'll find that text no longer fits inside boxes.



Glossary

Border
Box
Caret
Clipboard
Current Box
Current View
Default Layout
Layout
Level
Template File
Text Field



Clipboard

A temporary storage area for cut or copied information. You can paste the contents of the 
Clipboard into another chart or into a document in another Windows application.



Caret

In a word processor, the current position for text entry is indicated by a caret. With graphical
information, a simple caret isn't quite sufficient. In TreeChart, the caret is a thin red line 
which
surrounds a box. The surrounded box is called the Current Box. You move the caret to choose
a different Current Box.



Box

To TreeChart, a box is a number of lines of text. Each line of text is termed a Text Field. All 
boxes within a single chart have the same number of Text Fields. You must decide how many
Text Fields you need for each chart, and assign each a unique name, so that it can be 
referred to while preparing the chart.

The appearance of a box is specified by the Layout the box is using.



Current Box

In a word processor, the current position for text entry is indicated by a caret. With graphical
information, a simple caret isn't quite sufficient. In TreeChart, the caret is a thin red line 
which
surrounds a box. The surrounded box is called the Current Box.

Any command that can only operate on one box is always performed on the Current Box. 
Any
command that could operate on a number of boxes simultaneously is performed on the 
selected boxes, or if no boxes are selected, the Current Box.



Layout

A style guide; it determines how boxes appear, and how they are connected to their 
subordinates.

Layouts are similar to Style Guides found in more sophisticated word processors, and can 
greatly
assist you in achieving a consistent appearance to your charts. Once you've defined a 
Layout, you can use it as often as you like.

You can define any number of Layouts. Each must be assigned a unique name so that it can 
be referred to while preparing the chart. Every box in a chart uses one of the Layouts you 
have defined. When you change the settings of a Layout, it automatically affects every box 
using that Layout.

When you insert a new box, the Layout it initially uses is determined by the Default Layout 
settings.



Border

When your chart is to be presented, a Border is added. The Border acts as a frame around 
your chart, and can add titles, headers, footers or any other text fields that you need. The 
Border frames your chart not only when printing, but also when copying the chart to the 
Clipboard as a picture, and when saving a file in picture format.

Like a box, the Border can have any number of Text Fields, and it uses a Layout. The Text 
Fields defined for the Border are different from those defined for boxes.



Default Layout

The Layout a newly-inserted box initially uses. You can define a different Default Layout for 
each level in your chart.



Text Field

Text associated with a box is stored as fields. Each field has a name. All boxes within a chart 
have the same number of fields though whether a particular field is displayed for a particular
box is defined by the Layout the box is using, as is its style (font, size, color) and the relative
order and position of fields.

For boxes, TreeChart defaults to defining two text fields: Name and Position.

For the Border, TreeChart defaults to defining four text fields: Header, Footer, Title and 
Subtitle.

You can add, delete or rename fields at any time. You can also change the defaults by using 
a Template File.



Template File

A Template File is simply a chart that acts as a starting point when you create a new chart. A
Template contains:

Definition of Text Fields
A set of Layouts
Definition of Default Layouts
Other chart settings (Border, overall size rules, etc)

Template Files are normally given a filename extension of .TCT. Normally, a Template would 
contain no boxes, though you can store boxes in a Template file if you wish - these boxes 
would then be created automatically for you when you create a new chart.

TreeChart only recognises one Template File at a time, but you can switch Templates to any
TreeChart-format file whenever you wish.

The Template File is also used if you open a text-format file. This can greatly reduce the time
to
prepare a chart when importing text from other programs.



Level

The rank of a box within the hierarchy. The box at the top of the hierarchy is at level 1; 
subordinates to this box are at level 2, and so on.

Level numbers are not affected by any outlining selections you make: if a box is at level 5 in 
the full chart, it is also at level 5 if you Focus on it to make it the top-most visible box.

When you insert a new box, the Layout it initially uses it defined by the Default Layout for 
the level it has been inserted at.

You can select all boxes at a certain level, and match box sizes within levels.



Current View

The outlining selections you make define the Current View of the chart.

Wherever sensible, commands you select are always performed on the Current View. For 
example, the Select All command selects all boxes in the Current View.

The only operations that are always performed on the whole chart, rather than the Current 
View are:

1 Saving the chart (in TreeChart format or Text format)
2 Adding, deleting or renaming a box Text Field

Working with the Current View rather than the whole chart is particularly useful when you 
need to output the finished chart: if you print, copy a picture to the Clipboard or save a 
picture-format file, it is always the Current View.



TreeChart Commands - Quick Reference

Menu Shortcuts Description

File menu

New CTRL+N Creates a new chart.

Open CTRL+O Opens an existing chart.

Close CTRL+F4 Closes an opened chart.

Save CTRL+S Saves an opened chart using the same 
file name.

Save As Saves an opened chart to a specified file 
name.

Print CTRL+P Prints the Current View of the active 
chart.

Print Preview Displays the chart on the screen as it 
would appear printed.

Print Setup Selects a printer and printer connection.

Preferences Change TreeChart program preferences.

1,2,3,4 Opens one of four most recently used 
files.

Exit ALT+F4 Exits TreeChart.

Edit menu

Undo CTRL+Z Undo the last insertion or deletion.

Cut CTRL+X Deletes boxes from the chart and moves 
them to the clipboard.

Copy CTRL+C Copies boxes from the chart to the 
clipboard; optionally also copies box text 
and / or a picture.

Paste Below CTRL+V Pastes boxes from the clipboard into the 
chart below the Current Box.

Paste Left CTRL+L Pastes boxes from the clipboard into the 
chart to the left of the Current Box.

Paste Right CTRL+R Pastes boxes from the clipboard into the 
chart to the right of the Current Box.



Insert Above ALT+UP
Drag up from box

Insert a new box above the Current Box.

Insert Below ALT+DOWN
Drag down from 
box

Insert a new box below the Current Box.

Insert Left ALT+LEFT
Drag left from box

Insert a new box to the left of the Current 
Box.

Insert Right ALT+RIGHT
Drag right from 
box

Insert a new box to the right of the 
Current Box.

Box Text ENTER
Double click on 
box

Edit the text within the Current Box.

Mark Boxes CTRL+M Marks selected boxes as exceptions to the
Layout rules.

Delete DEL Delete selected boxes.

Swap CTRL+W Swaps the positions of two boxes.

Select All CTRL+A Select all boxes.

Select Level CTRL+H Select all boxes at the same level as the 
Current Box.

Select Subord CTRL+I Select all boxes directly below the Current
Box.

Select Sub-Tree CTRL+T Select Current Box, and all boxes below it.

Select Marked Selects boxes with specific marker 
settings.

Clear Selections CTRL+G De-select all selected boxes.

View menu

Toolbar SHIFT+F2 Show or hide the Toolbar.

Status Bar CTRL+F2 Show or hide the Status Bar.

View All CTRL+Q Show all boxes, by removing Focus & 
expanding collapsed boxes.

Focus CTRL+F Focus on Sub-Tree or the whole chart.

Collapse CTRL+K Collapse selected boxes, making boxes 
below them hidden.



Expand CTRL+E Expand selected boxes, revealing hidden 
boxes.

Expand All CTRL+SHIFT+E Expand all collapsed boxes, revealing 
hidden boxes.

Zoom In + Zoom in, to magnify a portion of the 
chart.

Zoom Out - Zoom out, to see more of the chart.

Zoom Normal = Restore to 100% zoom.

Layout 
menu

Define Layouts CTRL+D Define Layouts.

Edit SHIFT+ENTER
SHIFT+double 
click
on box

Edit the Layout used by the Current Box.

Size F8 Modify the box size rules of the Layout 
used by the Current Box.

Spacing SHIFT+F8 Modify the spacing rules of the Layout 
used by the Current Box.

Use Default CTRL+U Selected boxes use their Default Layouts.

Defaults Define a default Layout for each level in 
the chart.

Delete Unused Delete unused Layouts.

Chart menu

Define Fields F3 Define box text fields.

Border Fields SHIFT+F3 Define Border text fields.

Border Text F7
Double-click on
chart background

Edit Border text.

Border Layout SHIFT+F7
SHIFT+ double-
click
on chart 
background

Modify the Border Layout.

Border Margins CTRL+F7 Modify Border margins.



Match Box 
Sizes

Change the box size-matching rules.

Page Setup Change page margins and print style.

Window 
menu

Cascade Arranges windows in an overlapped 
fashion.

Tile Horizontal Arranges chart windows side by side.

Tile Vertical Arranges chart windows stacked vertically.

Arrange Icons Arranges icons of minimized chart 
windows.

Window 1, 2, ... Goes to specified chart window.

Help menu

Contents CTRL+F1 Offers you an index to topics on which 
you can get Help.

Search for Help 
on

Allows you to select Help by keyword.

How to Use 
Help

Provides general instructions on using 
Help.

Register How to register the program, and 
purchase a license to use it after the 30 
day evaluation period.

About Displays TreeChart version number and 
copyright.



Keyboard shortcuts

You can use keyboard shortcuts for commands and actions. Each shortcut key consists of a 
letter, symbol or function key, often pressed in combination with the CTRL, SHIFT and ALT 
keys. Choose any of the topics from the following list of categories to see which key 
combinations can be used to speed up common operations.
See also
Keys to Get Help
Keys for moving the caret
Keys for scrolling a chart window
Keys for selecting boxes
Keys for adding, removing and re-arranging boxes
Keys for changing box text
Keys for editing the Layout used by the Current Box
Keys for changing which Layout is used by selected boxes
Keys for marking boxes as exceptions to the rule
Keys for changing the Border
Keys for hiding boxes (outlining)
Keys for changing the scale at which a chart is displayed
Keys for managing the TreeChart application window
Keys for managing chart windows
Keys for choosing menus and commands
Keys for working with dialog boxes
Keys to access Toolbar buttons



Keys to Get Help

Use the following keyboard shortcuts to get help on working with TreeChart. TreeChart uses 
the standard Windows Help facility.

To Press

Get Help (context dependent) F1
Enter Help mode SHIFT+F1

Leave Help mode without getting Help ESC
See Help contents CTRL+F1



Keys for moving the caret

Use the following keyboard shortcuts to move the caret.

Moving the caret changes which box is the Current Box. If the new Current Box is not fully 
on-screen, the chart window is automatically scrolled to make it visible.

Note that all keys for moving the caret require Scroll Lock mode to be off. If Scroll Lock is on, 
these keys scroll the chart window without moving the caret.

The state of Scroll Lock mode is indicated on the TreeChart Status Bar.

To move the Insertion Point Press

One box left LEFT ARROW
One box right RIGHT ARROW
One box up UP ARROW
One box down DOWN ARROW
To the top-left box HOME
To the bottom-right box END



Keys for scrolling a chart window

Use the following keyboard shortcuts to scroll a chart window without moving the caret.

Scrolling the window 'a little' means 20% of the window; scrolling 'a lot' means 90% of the 
window.

Note that many keys for scrolling the chart window without moving the caret require Scroll 
Lock mode to be on. These keys are marked (SCRL). If Scroll Lock is off, these keys move the
caret; the chart window may then scroll automatically to ensure the Current Box is visible.

The state of Scroll Lock mode is indicated on the TreeChart Status Bar.

To scroll the chart window Press

Left a little (SCRL) LEFT ARROW
Left a lot CTRL+PAGE UP

Right a little (SCRL) RIGHT ARROW
Right a lot CTRL+PAGE DOWN

Up a little (SCRL) UP ARROW
Up a lot PAGE UP

Down a little (SCRL) DOWN ARROW
Down a lot PAGE DOWN

To the top-left of the chart (SCRL) HOME
To the left edge of the chart (SCRL) CTRL+HOME
To the bottom-right of the chart (SCRL) END
To the right edge of the chart (SCRL) CTRL+END



Keys for selecting boxes

Use the following keyboard shortcuts to select boxes.

Any TreeChart command that can only apply to on one box always applies to the Current 
Box. Any command that can apply to more than one box always applies to the selected 
boxes, or if no boxes are selected then the Current Box.

To Press

Toggle the selection status of the Current Box SPACE
Select all boxes CTRL+A
Select the Current Box and all boxes below it CTRL+T
Select all boxes at the same level as the Current Box CTRL+H
Select all boxes immediately below the Current Box CTRL+I
De-select all selected boxes CTRL+G



Keys for adding, removing and re-arranging boxes

Use the following keyboard shortcuts to insert, delete, cut and paste boxes.
To Press

Insert a box in an empty chart or view ALT+any arrow key
Insert a new box above the Current Box ALT+UP
Insert a new box below the Current Box ALT+DOWN
Insert a new box to the left of the Current Box ALT+LEFT
Insert a new box to the right of the Current Box ALT+RIGHT
Paste Clipboard contents below the Current BoxCTRL+V
Paste Clipboard contents left of the Current Box CTRL+L
Paste Clipboard contents right of the Current Box CTRL+R
Swap two selected boxes CTRL+W
Undo last box insertion or box deletion CTRL+Z

The following commands apply to the selected boxes, or if no boxes are selected then the 
Current Box:

To Press

Delete boxes DEL
Copy boxes to Clipboard CTRL+C
Cut boxes to Clipboard CTRL+X



Keys for changing box text

Use the following keyboard shortcuts to define the Text Fields in boxes and edit each box's 
text.

To Press

Define the Text Fields F3
Edit Text Fields of the Current Box ENTER

In the Edit Text Fields dialog box:

Move between Text Fields UP or DOWN
Move between text table, OK and Cancel buttons TAB
Extend selection in a text field SHIFT+DIRECTION key
Extend selection to first character in text field SHIFT+HOME
Extend selection to last character in a text field SHIFT+END
Copy selected text to Clipboard CTRL+C
Cut selected text to Clipboard CTRL+X
Paste text from Clipboard CTRL+V



Keys for editing the Layout used by the Current Box

Use the following keyboard shortcuts to edit the Layout used by the Current Box.

Note that other boxes may also be using the Layout used by the Current Box. Changing a 
Layout's settings will automatically affect all boxes using that Layout.

To change Press

Size settings F8
Spacing settings SHIFT+F8
All other Layout settings SHIFT+ENTER



Keys for changing which Layout is used by selected boxes

Use the following keyboard shortcuts to change which Layout boxes use.

The following commands apply to the selected boxes, or if no boxes are selected then the 
Current Box:

To Press

Choose a Layout from a list of those available CTRL+D to show Define Layouts dialog
Use the Default Layout for the level each box is at CTRL+U



Keys for changing the Border

Use the following keyboard shortcuts to define Border Text Fields, and change the text, 
appearance and margins of the Border.

To Press

Define the Border Text Fields SHIFT+F3
Edit the Border Text Fields F7
Change the Border Layout SHIFT+F7
Change the Border Margins CTRL+F7

In the Edit Border Text Fields dialog box:

Move between Text Fields UP or DOWN
Move between text table, OK and Cancel buttons TAB
Extend selection in a text field SHIFT+DIRECTION key
Extend selection to first character in text field SHIFT+HOME
Extend selection to last character in a text field SHIFT+END
Copy selected text to Clipboard CTRL+C
Cut selected text to Clipboard CTRL+X
Paste text from Clipboard CTRL+V



Keys for hiding boxes (outlining)

Use the following keyboard shortcuts to focus on one sub-tree of the chart, or collapse boxes
to hide boxes below them.

To Press

View the whole chart CTRL+Q
Focus on Current Box or chart root CTRL+F
Collapse selected boxes CTRL+K
Expand selected boxes CTRL+E
Expand all collapsed boxes CTRL+SHIFT+E



Keys for changing the scale at which a chart is displayed

Use the following keyboard shortcuts to change the zoom factor, which determines the scale
at which a chart is displayed.

To Press

Zoom In +
Zoom Out -
Restore normal zoom =
Set specific zoom factor F2 to open toolbar list,

then UP and DOWN to change,
then ENTER



Keys for managing the TreeChart application window

Use the following keyboard shortcuts to control the TreeChart application window and switch 
between applications.

To Press

Open the TreeChart application control menu ALT+SPACEBAR
Quit TreeChart ALT+F4
Switch to next application window or icon ALT+ESC
Switch to next application, restoring if minimised ALT+TAB

Move the TreeChart application window ALT+SPACEBAR to open the Control menu
DIRECTION keys to move the window
ENTER to complete the move

Change the TreeChart application window size ALT+SPACEBAR to open the Control menu
DIRECTION key to pick up a window edge
DIRECTION keys to move the window 
edge
ENTER to complete the re-size



Keys for managing chart windows

Use the following keyboard shortcuts to control a chart window and switch between chart 
windows.

To Press

Open the active chart's Control menu ALT+HYPHEN
Close the active chart window CTRL+F4
Switch to next chart window CTRL+F6
Switch to previous chart window CTRL+SHIFT+F6
Restore minimised chart window to previous size ENTER

Move the active chart window ALT+HYPHEN to open the Control menu
DIRECTION keys to move the window
ENTER to complete the move

Change the active chart window size ALT+HYPHEN to open the Control menu
DIRECTION key to pick up a window edge
DIRECTION keys to move the window 
edge
ENTER to complete the re-size



Keys for choosing menus and commands

Use the following keyboard shortcuts to choose menus or commands.
To Press

Get Help F1
Activate the menu bar F10
Choose the TreeChart window control menu ALT+SPACEBAR
Choose the chart window control menu ALT+HYPHEN
Close any open menu ESC
Close a chart window CTRL+F4

Choose the File menu ALT+F
Choose the Edit menu ALT+E
Choose the View menu ALT+V
Choose the Layout menu ALT+L
Choose the Chart menu ALT+C
Choose the Window menu ALT+W
Choose the Help menu ALT+H

Open a new chart CTRL+N
Open an existing chart CTRL+O
Save the active chart CTRL+S
Print the active chart CTRL+P

Show or hide the Toolbar SHIFT+F2
Show or hide the Status Bar CTRL+F2



Keys for working with dialog boxes

Use the following keyboard shortcuts to move between controls in a dialog box, and select 
options.

To Press

Cancel the dialog ESC
Move between controls or groups TAB
Move between controls or groups (reverse order) SHIFT+TAB
Move directly to control or group ALT+underlined letter
Move between options within a group DIRECTION key
Execute a command button ENTER
Open a drop-down list box ALT+DOWN
Select item in a drop-down list box ALT+UP or ALT+DOWN
Select or clear a checkbox SPACEBAR
Extend selection in a text box SHIFT+DIRECTION key
Extend selection to first character in text box SHIFT+HOME
Extend selection to last character in a text box SHIFT+END
Select next list-item beginning with a character character key

Extended-selection list boxes:

Select or cancel selection of item SHIFT+DIRECTION key
Select all items CTRL+SLASH (/)
Cancel all selections except the current selection CTRL+BACKSLASH (\)
Extend selection SHIFT+DIRECTION key
Extend selection to first item SHIFT+HOME
Extend selection to last item SHIFT+END
Select non-consecutive items SHIFT+F8 to begin 'add mode' (cursor 

blinks)
DIRECTION keys move between items
SPACEBAR to select or cancel selection of 
item
SHIFT+F8 to finish 'add mode' (cursor 
normal)



Keys to access Toolbar buttons

Use the following keyboard shortcuts to access buttons on the Toolbar. These keys can be 
used even if the Toolbar is not displayed.

To access the Press

New button CTRL+N
Open button CTRL+O
Save button CTRL+S
Cut button CTRL+X
Copy button CTRL+C
Paste Below button CTRL+V
Select All button CTRL+A
Select Sub-Tree button CTRL+T
Select Level button CTRL+H
Select Subordinates button CTRL+I
Mark Boxes button CTRL+M
Define Layouts button CTRL+D
View All button CTRL+Q
Focus button CTRL+F
Collapse button CTRL+K
Expand button CTRL+E
Expand All button CTRL+SHIFT+E
Print button CTRL+P
Print Preview button
Help Mode button SHIFT+F1
Zoom: open list F2
Zoom: change list selection UP or DOWN ARROW
Zoom: close list ENTER



Keys for marking boxes as exceptions to the rules

Use the following keyboard shortcuts to change the markers of the selected boxes, or if no 
boxes are selected, the Current Box

To Press

Show the Mark Boxes dialog box CTRL+M
Set the Invisible marker F9
Clear the Invisible marker SHIFT+F9
Set the Disconnect from Parent marker CTRL+F9
Clear the disconnect from Parent marker CTRL+SHIFT+F9
Set the Co-Manage Left marker F10
Clear the Co-Manage Left marker SHIFT+F10
Set the Co-Manage Right marker CTRL+F10
Clear the Co-Manage Right marker CTRL+SHIFT+F10
Set the Co-Manage Group marker F11
Clear the Co-Manage Group marker SHIFT+F11
Set the Assistant marker F12
Clear the Assistant marker SHIFT+F12

Note that the F11 key also sets/clears the Invisible and Disconnect from Parent markers.



Marking Boxes as Exceptions to the Rules

TreeChart minimises the amount of work you have to do by making two assumptions:

That all subordinates to a box are positioned and connected uniformly

That the hierarchy you are illustrating is 'pure': each box has only one parent

Most of the time you'll appreciate the benefits of these assumptions, but occasionally you'll 
find it useful to be able to mark some boxes as exceptions to the rules.

You can think of boxes as having a set of flags associated with them. Each flag indicates a 
particular exception condition, and you can set a flag to mark a box as an exception to the 
rule. By default, all the flags are cleared. The flags are independent, and can be combined in
any combination.

When you save your chart (in TreeChart native format or TreeChart Outline Text format) the 
flags are saved too. If you Cut or Copy boxes to the Clipboard then Paste them into a chart, 
the flags are copied along with the box text.

You can set or clear individual marker flags using the Mark Boxes command. Many of the 
flags also have shortcut keys which sometimes allow you to set or clear flags in common 
combinations.

You can select boxes depending on the state of marker flags using the Select Marked 
command.

For the meaning of the individual markers, see:

Assistant. 
Co-Manage Group. 
Co-Manage Left. 
Co-Manage Right. 
Disconnect from Parent. 
Ignore when matching Heights/Widths. 
Invisible. 



Mark Boxes command (Edit menu)

Boxes can be marked as exceptions to the Layout rules.

Use this command to change the markers of the selected boxes. See Marking Boxes as 
Exceptions to the Rules for an overview of marking boxes.

TreeChart displays the Mark Boxes dialog box. 

See Keys for marking boxes as exceptions to the rules. for keyboard shortcuts to mark 
boxes.

Shortcuts

Toolbar:
Keys: CTRL+M



Select Marked command (Edit menu)

Boxes can be marked as exceptions to the Layout rules.

Use this command to select boxes based on their marker settings. See Marking Boxes as 
Exceptions to the Rules for an overview of marking boxes.

TreeChart displays the Select Marked Boxes dialog box. 

See Keys for marking boxes as exceptions to the rules. for keyboard shortcuts to mark 
boxes.



Box Marker: Invisible

Boxes marked in this way are simply not drawn, but their connectors are.

The overall effect is that subordinates of an invisible box are positioned one level lower in 
the hierarchy than would normally be the case. Below, there is an Invisible box between the 
Director and the Researcher.

If you enter text in a box marked as Invisible, the text is drawn and obscures the connecting 
lines. This can be useful to annotate lines.

Shortcuts
Key to Set: F9
Key to Clear SHIFT+F9

Note that this marker is also set (or cleared) by the shortcut key associated with the Co-
Manage Group marker.    



Box Marker: Disconnect from Parent

Boxes marked in this way are simply 'disconnected' from their parent by omitting their 
connecting lines.

For Example:

Any part of the connector which is drawn purely to attach a disconnected box is omitted. If 
all subordinates are marked as disconnected, any common part of the connector is also 
omitted. If you do want to omit all connecting lines, its often easier to define and use a new 
Layout, specifying a connector line width of '(none)'.

Shortcuts
Key to Set: CTRL+F9
Key to Clear: CTRL+SHIFT+F9

Note that this marker is also set (or cleared) by the shortcut key associated with the Co-
Manage Group marker.    



Box Marker: Co-Manage Left

Boxes marked in this way have an additional connecting line drawn automatically: direct 
from the center of the marked box to the center of the 'nearest' subordinate of the box to 
the left on the same sub-tree.

For example:

This exception is useful for illustrating dual-reporting structures.

Shortcuts
Key to Set: F10
Key to Clear: SHIFT+F10



Box Marker: Co-Manage Right

Boxes marked in this way have an additional connecting line drawn automatically: direct 
from the center of the marked box to the center of the 'nearest' subordinate of the box to 
the right on the same sub-tree.

For example:

This exception is useful for illustrating dual-reporting structures.

Shortcuts
Key to Set: CTRL+F10
Key to Clear: CTRL+SHIFT+F10



Box Marker: Co-Manage Group

Boxes marked in this way are disconnected from their subordinates, and those subordinates 
are instead connected to the boxes to the left & right of the marked box (on the same sub-
tree).

For example:

This is useful in illustrating some situations involving a dual reporting structure. The marked 
box is effectively a placeholder    grouping a department actually managed by the boxes to 
its left & right.

The marked (placeholder) box is often also marked as Invisible and Disconnected from its 
Parent.

Shortcuts
Key to Set: CTRL+F11
Key to Clear: CTRL+SHIFT+F11

Note that these shortcut keys also set (or clear) the Invisible marker and the Disconnect 
from Parent marker



Mark Boxes dialog box

The Mark Boxes dialog box allows you to change the individual markers for the selected 
boxes. If no boxes are selected, the markers of the Current Box are changed.

For the meaning of the individual markers, see:

Assistant. 
Co-Manage Group. 
Co-Manage Left. 
Co-Manage Right. 
Disconnect from Parent. 
Ignore when matching Heights/Widths. 
Invisible. 

Each individual flag has its own checkbox. The checkboxes are three-state, which means 
they can be undefined as well as the normal on and off. The undefined state is indicated by 
a gray pattern. Clicking on a checkbox cycles through the three states.

When the dialog box is initially shown:

A checkbox will have an X if the corresponding flag is set in every selected box.
A checkbox will be blank if the corresponding flag was clear in every selected box.
A checkbox will be grayed if the corresponding flag is different in the selected boxes.

If you choose the OK button, the dialog box is completed, and the flags in the selected boxes
are changed:

Where a checkbox has an X, the corresponding flag is set in every selected box.
Where a checkbox is blank, the corresponding flag is cleared in every selected box.
Where a checkbox is gray, the corresponding flag remains unchanged.

If you choose the Cancel button, the dialog box is removed without changing any flags.

See also Keys for working with dialog boxes. and Keys for marking boxes as exceptions to 
the rules. for keyboard shortcuts to mark boxes.



Select Marked Boxes dialog box

The Select Marked Boxes dialog box allows you to select boxes depending on their marker 
settings.

Boxes selected using this dialog are added to those already selected. See Selecting Boxes 
for a summary of commands for selecting boxes.

For the meaning of the individual markers, see:

Assistant. 
Co-Manage Group. 
Co-Manage Left. 
Co-Manage Right. 
Disconnect from Parent. 
Ignore when matching Heights/Widths. 
Invisible. 

Each individual flag has its own checkbox. The checkboxes are three-state, which means 
they can be "don't care" as well as the normal on and off. The "don't care" state is indicated 
by a gray pattern. Clicking on a checkbox cycles through the three states.

When the dialog box is initially shown, all checkboxes are gray ("don't care").

Use the checkboxes to specify a search pattern. Checkboxes that are not "don't care" mean 
that the associated flag must be in the state (on or off) that you have chosen.

For example:

To select all boxes that with the Co-Manage Left marker set, and the Invisible marker set, 
and the Disconnect from Parent marker clear:

Co-Manage Left checkbox ON
Invisible checkbox ON
Disconnect from Parent checkbox OFF

When you choose the OK button, all boxes matching the search pattern are selected.

If you choose the Cancel button, the dialog box is removed without changing the current 
selections.

See also Keys for working with dialog boxes. and Keys for marking boxes as exceptions to 
the rules. for keyboard shortcuts to mark boxes.



Box Marker: Assistant

Boxes marked in this way are regarded as Assistants when subordinate to another box. This 
means that they are positioned and connected differently to the other subordinates.

For example:

This is useful in illustrating the common requirement when preparing an Organization Chart 
to indicate that this subordinate is actually an assistant, secretary or has a similar 
relationship to a manager.

Shortcuts
Key to Set: F12
Key to Clear: SHIFT+F12



Box Marker: Ignore when matching Heights / Widths

These two markers enable you to fine-tune the automatic matching of box sizes.

You can tell TreeChart to make all boxes (within various categories) the same size. All the 
boxes would then be enlarged to match the largest box. See the Match Box Sizes command 
for details.

These markers allow you either to ignore a particularly large box (and make all other boxes 
the same size as the second largest box), or to prevent a particularly small box from being 
enlarged.



The steps involved in preparing charts

At its simplest, preparing a chart is a five step process:

Define a hierarchy of boxes. See Working in a chart window

Enter the text for each box. See the Text command.

Specify how the chart should look. See Boxes and Layouts

Specify any titles and a border

Print the chart

Naturally, TreeChart lets you jump back and forth between these steps so you can try out your ideas 
before committing the chart to paper.



Printing charts

Printing TreeChart charts is much the same as printing any Windows document.

TreeChart always prints the Current View - that is, any outlining selections are applied to the printed 
chart as well as the chart displayed on the screen. What you see on the screen is what will be printed. To 
print the whole chart, you must view the whole chart.

The advantage of printing the Current View, rather than the whole chart, is that it allows you to print a 
chart as a series of pages. With an organization chart, for example, you could print top-level management
on one page, then each department on further pages. Each page would have its own Border and titles.

See also adding titles and a border.

See also Print, Print Preview and Print Setup.

Page Margins and Border Margins

When printing, the paper size is determined by the selected printer, the paper source, and paper 
orientation.

The Page Margins specify the distance between the edge of the paper and the border, even if no border 
is drawn because you chose a Border Line Width of (none) when editing the Border Layout.

The Border Margins specify the minimum distance between your chart and the border, and the absolute 
distance between the border and the Border Text Fields.

When printing your chart, the Page Margins are subtracted from the paper size to determine where the 
Border is. The Border Margins are then also subtracted to leave an area of paper available for the chart 
itself. If the chart fits in this area, its printed. If it doesn't fit in the area one of two things will happen:

If the Print Style is Fit to Page, the chart will be scaled to fit in the available area.

If the Print Style is Poster, the available area will be made larger to accommodate the chart. This is 
achieved by increasing the number of sheets of paper required. The Border will remain at the same 
distance from the paper edge, but will only appear on 'outer' sheets of paper.

No matter what size the chart is, or what Print Style is selected, the chart will always be centered 
vertically and horizontally within the 'available area'.

To change the Print Style, choose the Page Setup command.



Boxes and Layouts

To tap the full power of TreeChart, it is helpful to understand how the program manages your information, 
and especially the relationship between the text in a box, and how that box appears when drawn.

What's a Box?

To TreeChart, a box is a number of lines of text. Each line of text is termed a Text Field. All boxes within a 
single chart have the same number of Text Fields. You, the user, must decide how many Text Fields you 
need for each chart, and assign each a unique name, so that it can be referred to while preparing the 
chart.

Isn't this rather restrictive? No -

- You can add, delete or rename Text Fields at any time
- The arrangement and appearance of Text Fields when a box is drawn is determined by

what Layout the box is using

What's a Layout?

A Layout defines how a box appears in a chart. Settings stored in a Layout include:

- Text Which Text Fields are visible
Their position
Their font,    size, color, etc

- Box Shape
Shadow direction, depth & color
Size (ie text margins, minimum size, aspect ratio control)
Border width & color
Interior color

- Connections Arrangement of this Box and its subordinates
Spacing
Line width & color

Layouts are similar to Style Guides found in more sophisticated word processors, and can greatly assist 
you in achieving a consistent appearance to your charts. Once you've defined a Layout, you can use it as 
often as you like.

You can define any number of Layouts. Each must be assigned a unique name so that it can be referred 
to while preparing the chart. Every box in a chart uses one of the Layouts you have defined. When you 
change the settings of a Layout, it automatically affects every box using that Layout.

When you insert a new box, the Layout it initially uses is determined by the Default Layout settings.

What are Default Layouts?

With every chart you can set Default Layouts. This table tells TreeChart which Layout a newly inserted 
box should initially use. The Default Layout can be different for each Level in your chart

Not only inserted boxes initially use their Default Layout, but also boxes created when opening a text-
format file. So by defining some Layouts, setting Default Layouts, and storing them in a Template file, 
ready-to-print charts can be generated from text-format files almost instantly.



What are Template Files?

A Template is simply a chart that acts as a starting point when you create a new chart or open a text-
format file. A Template contains:

- Definition of Text Fields
- A set of Layouts
- Definition of Default Layouts
- Other chart settings

Template Files are normally given a filename extension of .TCT. Normally, a Template would 
contain no boxes, though you can store boxes in a Template file is you wish - these boxes would then be 
created automatically for you when you create a new chart.



Adding titles and a Border

When your chart is to be presented, a Border is added. The Border acts as a frame around your chart, 
and can add titles, headers, footers or any other text fields that you need. The Border frames your chart 
not only when printing, but also when copying the chart to the Clipboard as a picture, and when saving a 
file in picture format.

The process of deciding how the Border appears is very similar to deciding how an individual Box 
appears:

Define what Border Text Fields you need

Enter the Border Text

Change the Border Layout

Change the Border Margins

The similarity goes further, and in most respects the Border can be thought of as a special Box into which 
your chart is placed.

All commands for changing the Border are on the Chart menu.



Speeding up your work with Template Files

A Template is simply a chart that acts as a starting point when you create a new chart.

A Template contains:

- Definition of Text Fields
- A set of Layouts
- Definition of Default Layouts
- Border text and Layout
- Page margins and print style (poster or fit-to-page)
- Overall box size-matching rules
- Custom color settings

Normally, a Template would contain no boxes, though you can store boxes in a Template file 
if you wish - these boxes would then be created automatically for you when you create a 
new chart.

The file format of Templates is identical to charts, but Template files are normally given a 
filename extension of .TCT to indicate they serve a different purpose.

There are two situations where a Template is used:

- When you create a new chart
- When you open a text-format file

In both cases, TreeChart simply reads the Template File you have specified before allowing 
you to modify the chart or reading the text-format file.

If you change the settings of a Template File, for instance, changing some colors, this will not
affect charts previously created from this Template, only charts created after the change.

If you choose not to specify a Template File, or TreeChart is unable to read the Template File 
you have specified, TreeChart uses a built-in default Template.

To create a new Template File:

Since a Template is simply an empty chart, creating a Template is just like creating a chart, 
then deleting all the chart-specific information (ie the boxes):

1 Prepare a chart
2 Delete all the boxes
3 Save the (empty) chart with a filename extension of .TCT

For step 1, you could open an existing chart whose style you wished to use as a Template, or
open an existing Template, or create a chart from scratch.

To edit an existing Template File:

Since a Template is simply an empty chart, editing a Template is just like editing a chart, 
then deleting all the chart-specific information (ie the boxes):

1 Open the Template File
2 Temporarily insert some boxes to illustrate the changes you'll make



3 Make the desired changes
4 Delete all the temporarily inserted boxes
5 Save the Template

To specify which Template File to use for newly-created charts:

1 From the File menu, choose Preferences
2 In the Preferences dialog box, select the file to be used as the Template.



Inserting new boxes

You can insert a new box above, below, to the left or to the right of an existing box. The 
existing box you'd like the new box to connect to must first be made the Current Box.

Box insertion works in terms of the hierarchy rather than where boxes are drawn. For 
example, to add a co-worker under the same manager, you would always insert left (or 
right) of an existing box. Where the new box gets drawn in relationship to the existing box is 
a separate issue.

If you insert a new box below a box that has subordinates, all those subordinates are 
'demoted' and become subordinates of the newly-inserted box. In Organization Chart terms, 
inserting a box below a manager creates a new middle manager position.

When you insert a new box, the Layout it initially uses is defined by the Default Layouts.

After a new box is inserted, the caret is always moved to make the new box the Current Box.
If necessary, the chart window is automatically scrolled to make the newly-inserted box 
visible.

After the new box is inserted, you may automatically be prompted to enter the text 
associated with the box. See the Preferences command for details.

If you insert a new box above, to the left or to the right of a box marked as an Assistant, the 
new box is automatically marked as an Assistant, too. See Marking boxes as exceptions to 
the rules.

If you make a mistake when inserting a box, you can undo the insertion.

Inserting a box with the mouse

With the mouse, you can insert a new box connected to an existing box by simply dragging 
from the existing box. See using a mouse in a chart window for details.

Inserting a box with the keyboard or menus

1 Move the caret to the box you'd like the new box to be connected to.

2 either Insert Above
or Insert Below
or Insert Left
or Insert Right

Inserting a box in an empty chart

Inserting a box in an empty chart is just like inserting subsequent boxes, except that you 
don't have to tell TreeChart which box the new box should be connected to. The keyboard 
and menu box insertion commands are unchanged.

To insert a box in an empty chart with the mouse, drag from anywhere in the chart window.



Register command (Help menu)

TreeChart is not free. It is not public domain. Just like a computer program costing ten times
as much, it is copyrighted by its owners, and you must purchase a license to use it.

Unlike a computer program costing ten times as much, you have the chance to try the 
program before you commit yourself to purchasing the license. This 'try before you buy' 
concept is termed Shareware.

In essence, FineLine Software are granting you a limited-time trial-use license to evaluate 
this program to determine if it meets your needs. If, after 30 days, you wish to continue 
using this program, you must purchase a full license for continued usage. This process is 
termed Registration.

Use this command to register.

TreeChart displays the Registration dialog box.

Registration brings many benefits over and above the right to use the program. See the 
Benefits of registration for details.



Registration dialog box

If you wish to continue using TreeChart after the 30-day evaluation period, you must 
purchase a license by registering. The Registration dialog informs you of the various ways of 
registering, and the costs involved with each. The dialog can also print an order form if 
needed.

Site licenses and volume discounts are also available - contact FineLine Software for details.

See also the Benefits of registration.

The two choices you must make are:

1. The payment method.
2. Where we're shipping the registration package to.

Your choice in the Payment Method list determines who you should place your order with, 
and the currency that prices are quoted in. You can order direct to FineLine Software from 
anywhere in the world, but customers in the U.S.A. or Australia may find it more convenient 
to order through our local registration agents.

Your choice in the Location list determines postage costs and VAT (sales tax). All 
registration packages are shipped by airmail post from Ireland. VAT is only significant if we 
are shipping within the European Community. Due to VAT complications, orders through our 
U.S. or Australian registration agents are always charged at the 'Rest of World' postage rate.

Ordering by phone / E-mail

If you have a credit card, you can phone or E-mail your order. There's no need to complete 
the remaining fields in the dialog, but you'll need to provide this information when placing 
your order.

Ordering by post / fax

Please complete all applicable fields. Choose the Print button to print a pro-forma invoice / 
order form. Please use this printed form, rather than a handwritten order, since it makes it 
much more likely that we'll get all the details correct. If you chose to pay by credit card, 
you'll need to add your credit card details to the printed form.

A customer comment form is also printed. Your feedback helps us to improve the program, 
the documentation and our distribution methods. If you don't wish to make any comments, 
you could just print the first of the two pages.

You cannot print the forms unless you complete the Name, Address and Country fields.

Customs Duties

Customers outside the E.C. may have to pay customs duties to import our product into their 
country.

We ship by airmail post. This will often be regarded as personal mail, and not dutiable. 
Where customs duties are payable, we minimise them by itemising the package contents on 
the customs declaration form:



disk: US$1
book: US$8

intellectual property
license:

US$33

We understand that in most cases only the disk will be dutiable. In some cases, the book 
(manual) will be. Almost never are intellectual property licenses dutiable.

Rates and regulations vary between countries: to avoid unexpected costs, you should 
enquire at your local customs office.

Price Stability

Where possible, we will honour the indicated total cost for two years after the release date. 
If you see a message warning you that you are running an old version of TreeChart when the
program starts, then your copy was released at least two years ago, and prices may have 
changed. You should contact us (or our local agents) for current prices, or obtain an up-to-
date copy of the program.

A significant change in VAT rates or legislation is probably the only thing that would cause us
to have to change the total cost.



Value Added Tax

VAT is the European Community term for a sales tax. All sales are subject to VAT, but the 
rate used depends on a number of factors.

The main factor is where we're shipping to, as indicated in the Location list in the 
Registration dialog:

If we ship outside the E.C (Rest of Europe or Rest of the World), the rate is 0%

If we ship within the Republic of Ireland the rate is 21%

If we ship to another E.C. country (United Kingdom or Rest of E.C.), the rate depends on 
whether or not you are registered for VAT. If you are registered, the rate is 0%; if you are not
registered, the rate is 21%. If you are registered, select the VAT Registered checkbox to 
view costs with the 0% rate. You must also provide your VAT registration number (including 
country prefix). When we receive your order, we will verify this number before acceptance. 
Selecting the Registered checkbox without entering some sort of VAT number will cause an 
error message if you try printing a pro-forma invoice / order form.

Note that postage charges reflect actual costs and are charged separately. They are 
therefore not liable to VAT.

The complications caused by VAT are the main reason that orders placed through our U.S. 
and Australian registration agents are always charged at 'Rest of World' postage rates: 
orders placed through these agents for an E.C. destination are still liable to VAT. FineLine 
Software pays the VAT from the extra postage included.

A VAT invoice is included in the registration package for all orders shipped within the E.C.

VAT rates and legislation are subject to change.



Australian Registration Agent

Customers in Australia,    New Zealand or the Pacific Islands may find it convenient to 
register through our local agent:

Budgetware
PO Box 496
Newtown, NSW 2042

voice: (02) 519-4233
fax: (02) 516-4236

Budgetware accept the following credit or charge cards: Bankcard, Mastercard, Visa. 
Budgetware also accept mailed orders with an Aus$ cheque drawn on an Australian bank or 
money orders. These should be made out to "BUDGETWARE".

The above phone numbers are for orders only. Any questions about the status of the 
shipment of the order, refunds, registration options, product details, technical support, 
volume discounts, dealer pricing, site licenses, etc, must be directed to FineLine Software.

Orders placed through our Australian agent are E-mailed to us the day you order. Your 
registration package will then be dispatched by airmail post within 48 hours. Please allow a 
total of 15 days for delivery.



Registering direct to FineLine Software

FineLine Software can accept worldwide orders by a number of methods.

FineLine Software
Newtown,
Kinvara,
Co. Galway,
Republic of Ireland

voice/fax: (+353) 091 37560
CIS: 70624,462
via Internet: 70624.462@compuserve.com

FineLine Software accept the following credit cards: Mastercard, Access, Visa and Eurocard.
FineLine Software also accept mailed orders with Irish cheques, Sterling cheques, 
eurocheques and International Postal Money Orders.

Your registration package will be dispatched by airmail post the day after receipt of order. 
Delivery should be 5-10 days later.



U.S.A. Registration Agent

Customers in the U.S.A. may find it convenient to register through our local agent:

Public (software) Library
PO Box 35705
Houston, TX 77235-5705

toll-free: 1-800-2424-PsL
voice:  713-524-6394
fax:  1-713-524-6398

When ordering, please quote item #11053.

PsL accept the following credit or charge cards: Mastercard, Visa, Amex and Discover. PsL 
also accept mailed orders with a US$ check drawn on a US bank, payable to "Public 
(software) Library".

The above phone numbers are for orders only. Any questions about the status of the 
shipment of the order, refunds, registration options, product details, technical support, 
volume discounts, dealer pricing, site licenses, etc, must be directed to FineLine Software.

Orders placed through our U.S. agent are E-mailed to us the day you order. Your registration 
package will then be dispatched directly to you by airmail post within 48 hours. Please allow 
a total of 15 days for delivery.



The Benefits of Registration

As well as the legal right to use TreeChart after the 30 day evaluation period, registration 
brings you:

Printed and bound User Guide plus Tutorial
The most recent copy of the program
Lifetime support and a money-back guarantee
'Unregistered version' messages now show that you're another honest shareware 

user
Support if file format changes
Registration remains valid for minor upgrades
Notification of both minor & major upgrades
Automatic (& free) re-registration if a major upgrade is released within six months
Its the right thing to do

Refer to the User Guide for details of our upgrade and support policies.

Changes to the .TCF file format

We aim to continuously improve TreeChart, and in so doing it may be necessary to change 
the way we store your information. This is of no consequence during an evaluation period, 
but becomes significant if you wish to read files saved under an old version of TreeChart into
a newer version. The registered version of TreeChart contains code to automatically detect 
and handle format changes, unregistered versions omit this code, and can only report an 
error if you request an old-format file to be loaded.

TreeChart is produced by a member of the Association of Shareware Professionals (ASP).
ASP wants to make sure that the shareware principle works for you. If you are unable to 
resolve a shareware-related problem with an ASP member by contacting the member 
directly, ASP may be able to help. The ASP Ombudsman can help you resolve a dispute or 
problem with an ASP member, but does not provide technical support for member products. 
Please write to the ASP Ombudsman at 545 Grover Road, Muskegon, MI    49442-9427 U.S.A. 
or send a CompuServe message via CompuServe Mail to ASP Ombudsman 70007,3536. The 
OMB may be contacted by FAX by sending to the ASP FAX number: (+1) (616) 788-2765. In 
communication with the OMB please include a telephone number and/or FAX if available.




